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0—RNRNT T ENRTLOZMNERH Y FT (ZOHFIET v TA R —LA AL vF E

<) .
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Load Balancing: ==
PBR or ECMP %

eth0/0

eth0/1

eth0/2

eth0/3

Inside Switch Outside Switch
]
Node1/Control == Load Balancing:
PBR or ECMP
inside elh1f2 eth1/1 outside etho/0
10.1.1.1 (main) 209.165.201.1 (main) e
10.1.1.2 (local) 209.165.201.2 (local)
Node2
inside eth1/2 3P cih1/1 outside stho/
10.1.1.3 (local) #200.165.201.3 (local) o b
Node3
inside eth1/2 eth1/1 outside etho/2
10.1.1.4 (local) 209.165.201.4 (local) b
Node4
inside eth1/2 em1:'1 outside etho/3
10.1.1.5 (local) #209.165.201.5 (local) .

RKIVo—_R—=2ANV—FT 4T (=T R T7A4T U+ —/LE— D)

A v Z—T 2 AEFHTDEEE, FASAA A —T 2 A ANEHDIPT FL R &
MACT RULAZHFLET, e— R ARXFUU FHED1OB, R —_"—2 L—F (
7" (PBR) T,

ZOFENEREINDDIE, §TICPBREZHEHLTEY, BBEOA 7T AN T 7 F v &G
A L7=WEE T,

PBR %, —F v 7BIXOACLIZHEASNWT, L—TF 4 V7 OREEITVET, EHEIX
FEITCRNI 74w 7% TAZNOTXTO ASA M THITHMERH Y 77, mRi#%T
HLHID, WITEERA— RN T UV TREREZFRTERNWZ bV £, mmD/X7 4+ —
VU REEMRT HIZIE, PBRAY —ERET HEXIT, RCEROTZ7+ TV —RE VX4 —2D
N7y RBREICASAICE R SND LI ETHZ 2R LET, =& 21X, Cisco/l—#
NH LA, ILEMEEZFERT 511X CiscolOSPBR A4 7 Y= 7 b T vF o 7L &I
ALET, CiscoloOS A7 V=7 b bT7vX 7, ICMPping i L THK ASA 2 E=4%—
LEJ, ZH T, PBRIL, FFED ASA DEEFGEMEIZE SN TL— vy T2 A X —T L F
FIETF 4 =7 M TEET, FEMICONTIZ, RO URL BB L TL 72 &,

http://www.cisco.com/c/en/us/solutions/data-center-virtualization/intelligent-traffic-director/index.html

http://www.cisco.com/en/US/products/ps6599/products_white paper09186a00800a4409.shtml

%:[X ARSI % AV J—T 4 Va4 (}1/»—5‘*\\/ N 77/(7'71“—/1/:5‘— ]\\0)%{)

ERIA v Z—T 2 A REEHT DL XL, HFASAAS L FZ—T A ZAREHOIP T RL A&
MACT F‘I/X%;ﬁﬁﬁbiﬂ—o E_F‘/\\?\/“/\/ﬁ‘jﬁYﬁ@l/)Zﬁ\ %:{X ]\'7/1/3;/\02 (ECMP)
N—TFT 4 T TY,
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Nexus Intelligent Traffic Director (JL—T v F 774 70+ —J)L E— FD#H) .

ZOFEPHEREINADIE, T TICECMPZHERALTRY, BEFOA V7T A NT 7 F ¥ &Ik
HAL7zWEE T,

ECMP/V—T 4 7 TlE, =T 47 A M) v 7 NEMECHRETHLIEED TEKiE/ A %
ML Ty FZEEETE £9, EtherChannel ® X 912, FHETLB L USELEDIP T KL ARLE
BB IUOSEEDOR—= DNy a2zl L TR I A NE Yy TDO1IDII Ny Mk T&F
9, ECMP V—T 4 UV JIZAXT 4 v 7 )— b &2HHAT DAL, ASA OFEER AR IR E
DEEZLHZENHVET, L— MISIEHEMEHINL D, EENFEAELT ASA~D 7
T4 IBRONDENETT, A¥T v 7 —’EFHTIHAEENT. 7= b
TOXVITREDAZT 47 V— ] T =) VITHERERHERA L T ESWN, ¥4 F Iy
JNV—F 47 Fa halEER L TL— FOBEMEHIREIT) L2 R LET, 2ol
Bl ZAFTI I N—T 4V TIZBIMNTDHEIICE ASA ZRETHLERDH Y £7°,

Nexus Intelligent Traffic Director O)V—7 > K 77 A 7 U 4 —/L F— RDH)

fERA 2 —T oA ABMHTHEEIE, FASAA L H—T oA APRFEHOIP T LR L
MAC 7 R L A% #EFF L £ 7, Intelligent Traffic Director (ITD) & %, Nexus 5000, 6000, 7000
BEUY000 A1 v F ) —ADEHN—RT =7 B—RARF v/ VY a—va T,
$EK D PBR OIEREA SERICHERE L T\ D Z L ialx, il b Stk Y — 7 7 o — & 42t
L. RLEE DDA /3 R KBS 5 720 OB OBIERE 2 2 T\ E T,

ITD 1X, IP A7 ¢ v, WHR 70 —RPEDT= DD a L v A7 o ks Ny rajh, AR IP
TRy o7 SVAE=L =Y T GERBEELEARY — (NHMITEM) . NEr—
KRGy BEXOT U7 —32 9 IPSLA 7u—7 (DNS #5ie) #¥R—KLZE

To B— RNZ U U T OEBNRMEEIZE Y, PBRIZHKART, 3XTHOIT TAH AL N—T
0= v T 7 4w 7 BEERLET, MR T a—xHEE EB T 572012, #Eio

TV —FRBIORU Z—2 08 EREIT ASA ICEEEND L HICITD 2R ET 52 & &
RLES, FHMICONTIZ, KO URL ZZRL T 7EE 0,

http://www.cisco.com/c/en/us/solutions/data-center-virtualization/intelligent-traffic-director/index.html

DISABAZY DT —TIWEHRET Y TRARMN)—LBLEUAY R M) — LHESED

P TGARY T EFRETDHANS, 7 TAZGEAY) 7 2y hU—2 FHRXxy FU—7 BX
WNF—% Xy NI =2 2 lr—T VTR L £,

FIE

TIARAFEIY v Ry VU= By NU—7 BXOT—X Xy NI—T B —T
JVCHHE LET,

(B) 772 ZIZBMT DL =y NERETDHNC, PR b, 77T 47007
AZHY 7 Ry b U =T BHBETT,
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TyTARN)—LEHT T AN —AOMEHRET DMLENH Y 7, 72& %X, EtherChannel
Z 9 53HA 1%, EtherChannel D7 7 A kU —AL/Z 7 A b — AEER 2R E T D LEN
HYET,

HEHI=Y FTDISRAE A VE—T AR E—FDETE

\}

TGARY L TRICBRETXAL X —T 2 ADF A 7%, A3 KEtherChannel & #2311
V=T 2 ADNTNID—FDOHLTT, 1O0DF FAZNTA L H—T A AXA T HIRIE
IFAHZEITTEET A,

GE)

ATy T

flflr=y "o TF—F 2=y NEBNLAWEAIE, flffla=y N2 Th<L2=v b
A H =T x A AT — REZOHEOHRFIZHE> CFEITRET DLERHD 3, Hilfflz=
b F ) 2=y MBI 58551%, ASDM BT —X 2=y hOA X —T oA A
E— FZHBIICHEELET,

1R BRI

EHEHA VA —T 2 ATV OTH, A v H—T A A (HiE) L L TRETEE
3 (A% KEtherChannel TE— RO L & TH) , HBHA L X —T = A A1, @A X —
TxAARELTHENTEET (T AXT LU 77 AT U4 — /)L E—RDEXT
%)) [e]

o 2% K EtherChannel E— R T, BHA v X —T =2 ZAZl A v X —T =4 AL LT
WETDHE, BHA LA —T oA AKX LTHA T IvIN—T 4 T oA RX—TNITT
TFEVA, AT 4T N— b EFEATAINERHY 9,

“IF arTFHFANET—RTIE, TR_XTOasTFRARMIH LTI DDA o F—T = A
AR TERBINTDMLENHY FET, e, FTF AT LU N E—REAL—T v
FRE—=ROaTHFAIBRMELTNDEAIL, T XTOa s TF A MIANSER
EtherChannel T — R&{FHTAHILERNHV £, ZB, FT AT L FE— RTHF
A SNDME—DA LB —T A A XA T THHNLTT,

FIE

il =~ k™ ASDM . [Tools] >[Command Linelnterface] DIEIZER L £4, AHarED 2
War 74 Xalb—rvarEgFoaLl, Ml ¥ —T7 2 A EFE—RIZLTH T 7 o
Fal—va yeBETELLOICLEY, Z0Oavry FTERE-FILESNEEA,

cluster interface-mode {individual | spanned} check-details

1 :
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&

HE1=y rTOs528 1v8—7x142 2= roRE [

| ano Command Line Interface

Type a command to be sent directly to the device. For command help, type a command followed by a question mark. For commands that would
prompt for confirmation, add an appropriate noconfirm option as parameter to the command and send it to the device. To make the changes
permanent, use the File > Save Running Configuration to Flash menu option to save the configuration to flash.

Command

(#) Single Line Multiple Line [ Enable context sensitive help @)

cluster interface-mode spanned check-details

Response:

Result of the command: "cluster interface-mode spanned check-details"
ERROR: Please modify the following configuration elements that are incompatible with ‘spanned' interface-mode.

= A cluster IP address pool must be specified on interface Gi@/@(outside). Or remove IP address configuration.
= A cluster IP address pool must be specified on interface Han@Emanagement]‘ Or remove IP address configuration.

Clear Response

_Help | [ Close | [ESendi]

IE A F =T 2 A AF—FERE LKL, FITA =T oA ATHERTEDH LI

J

ROET, 2L, 7T RAZ Y U BEBICEET AL OICEEA LA —T o AR
ETDHANCASAZ Y v —RT5 L (LEziE, 7 I7AXIPT—)1VEBNT5720) |
0T AREHERIEDRNA L E—T 2 A AT 4 Falb— g URHIREND T
O, B TR RV ET, TOHAIX, a Y — R — MR LTA U Z2—
T2 A AT 4 Fal—a  EAEETLILERDY 3,

FGAEZN U THIA VA =T 2 AT FERELET,

cluster interface-mode {individual | spanned} force
1 -

ASAY S R4 .
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ATvT3

@no Command Line Interface

Type a command to be sent directly to the device. For command help, type a command followed by a question mark. For commands that would
prompt for confirmation, add an appropriate noconfirm option as parameter to the command and send it to the device. To make the changes
permanent, use the File > Save Running Configuration to Flash menu option to save the configuration to flash.

Command
(*) Single Line Multiple Line [ Enable context sensitive help ()
cluster interface-mode spanned force e
Response:

Result of the command: "cluster interface-mode spanned force"

WARNING: Cluster interface-mode is changed to 'spanned' without walidating compatibility of the running configurat

Clear Response

Help Close

TNV IIRTEIEH Y EE A, HRICE— FE2ERTIXLERH YV E, T—FREZHRTLT
WRWEARE, 7T AX D VT A X—TNIZTEERE A,

force 47 a v EIEET D &, HEMEORWa Ly 7 4 X o L— g COREIIITHOFICE—
RMNEEEINET, 2074 X2 —2aryOfENDLILAIE. T— FE2ELE L-R%RICTH
TIRRT HMERHVET, (X —T oA XA AT 4 Fal— g VOEERTXHDIE
F— ROBRTERICIEOLNLDT, forced I a v BEATAIAZ 2B LEST, 2D LT
THE., HIETH, BBEOa L 7 4 X2 b—2a vV ORENLBETEXEST, ST X
ANMBEIRGANEL, T— R&R%E L7 C check-details 47> 2 2 HFEITLE T,

force 47 a v EZIEELRWE, AfEOR NI T 4 Fa Ll —a v RNHLBRAE, v
T4 Xal—varE7VT7LTIa—RT5K5kOoNDDT, a2y —LiR— M
BLTEHT 7B RAEHRETHILERHY £9, a7 4 X b— g NZHBMOREN
WA (ENr—R) | B RRPEEIN, a7 4 X b— g TR SN ET,
AT 4 X2l —varEZ VT LELSBWEASIE. nZ AL Ta~vr REKTLET,

A B —T 2 A A F— R&EfEERT 5121, nocluster interfacemode =~ > F&Z AN LET,
ASDM ##4T7L, Ve—RLET, VI7AF A X —T oA A EF— RIZIELLFHETAH LD

\Z ASDM Z HiEBI T 52 L ERH Y £9, Unr— KDk, F—L ~X— U2 [ASA Cluster] Z 773
FRENET,

ASAY S R4
TR I
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(8, TAFILTHR FE—RTRBA $@1=y rToqvs—Tz120%% [

Device Information

| General License QEGECREIE

Cluster Interface Mode: Spanned EtherChannel

Cluster is not enabled.

Details

(HEE, TIALFAVTXFAME—FTRERA) H#HI=Y FTOA2E2—T 114 ADK

E

I TABN T ERENCT LRI, BUEIP T RLARRESN TWDHA LV —T = Af A%
TALKICERT HMENRH Y £7, Dl &b, ASDM BEERER SN TV HEHA v
H—T 2 ABEETIHVLENHY FI, OA o F—T = ZAZOWNWTIX, 7 T7AX VT
BARX—T T HRMERITI LB TRETEET, BRI T4 Falb—Ta UBH LN
JTAZAUNERMT LI, TRTOA U F—T oA AZFRNIHRET H T & AHELEL
T, vAF aAaryTFARNET—-RTIE, ZOHOFIAZMEH LT, BEFOAL v F—T = A A
EEET D, LA F—T oA RAERETDHILENSY 3, —FH, Y7 LE—RT
X, ZOIEEAME L. High Availability and Scalability 7 ¢ %' — R CIHil@A v ¥ —T =4 X XF
A—HERETEXET (EAHEY A V= REERA L7 FAZOEKREEZSM (36 <—
V) ) . ERA X —T = A A EtherChannel DIEK 72 FDOBESRA LV X —T =1 A
REILY AP — FTIEFATTE RN I LICTERE LT EEN,

TITHEH, IIRZV U THBERDZ I AV E—T oA REFRTET D HIEIZOWTHBAL
4, T—H A H—T A AlX. A3 KN EtherChannel & L CRRETAHZ & 6. fEB]A
F=T A RELTRETHIEHTEET, FHANIBOO—KNT U T A=A N %
EALES, MU TR IO A TE2RETHILFITEEEAR, B F—T AR
IZHI4+ T, A, K EtherChannel €— R CToH > CTHEHBIA X —T = A AT TEET,

BERA V2 =T 24 ADFKE (FEA V3 —7T A XITHR)

TERA > B —T =2 ATBEDON—T v RA L HE—T =24 ATHY, TNENNEHDIP 7
RLVAZIPT RLVA =M BELET, AAMV 7TAXIPT FLAL, FOT T AKX
DIZHDEET RLATHY, HICHEDT 74~ 2=y MIBLET,

Z %y K EtherChannel € — N TlE, BHA L X —T oA ZAZEYA v X —T =2 AL LTHRE
THZLEEMELES, EREHA X —T A A 51E, BEIDS U THFI= MOEER
Wi Cx £33, A% REtherChannel f > % —7 = A A TlL, BEDTTFTA <V 2=y h~D
B L TEEEA,

4RO HREIIC

CERBA L5 —T = A ADHEEIRE | AR 2 —T = A AT TS 2 LILE
<7

ASAY S R4 .
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B Err 5oz zoBe BELS—T(RIED

cwNTF AUTHXARN BT ROBAIE, ZOFEEE L THFARNTIITLET, 22
VTFXAR a7 4 Xal—r gy E— FIZA- TWARWEAIL, changetocontext name
o~ R& AJ)L £, [Configuration] > [Device List] XA > C, 77T 4 7727 /54 AD
IP7 RLADFIZHDHALTIRANELT LI Y v 7 LET,

AEBA L H =T 2 ADGEIT, XA N T AL ATOR— R NRNFG UV T EBRET D
WERBHY FT, BHA X —T oA AL, SO — R RT U o TII0EH D £H
Po

s (ATvav) A H—T oA A%ETNA A —N /L EtherChannel f X —7 = A A & L
TRET D, WEA LV H—T oA AERET D, BIOVTA L H—T oA AERET D
VEZ A VBT GH U TITWE T,

* EtherChannel D34, Z @ EtherChannel I = MMZxfLCr—H/LTHH, A/
R EtherChannel TiZdH ¥ FH A

EHEHA LA =T oA AETRA V=T 2 AT DHILIXTEERA,
cASDM A L CTEHA v X —T = A A2V T— M L TV DEEEIE, kot h v
Y 2=y FOBIEDIP 7 R L A T—R722 b DT,

e H AL, FTIAFY 2=y P TCERINZI TAXIP F—A0EIPT KL A
NEID L THNET,

o 7T AKIP =ML, FROEDLFZVIPT RLRAEET, 2y NI —2TT T
WERFOT RLAZEDDLZ LT TEERA,

Il =R L ET,
1. 794~ 2=y MZ10.1.1.1 ZHFTELET,
2. fho==v NI, 10.1.1.2, 10.1.1.3, 10.1.14 ZHEHL £,

3. 94 a2y v DITRAEDIP SN ERETLHEES. FHFTHLL-D
122, 3. ADT RLAZTF—NIZEDH T LITTEXEH A,

4. Rbvilz, 5, 6, .7, 8OEH7, Xy hIT—7DMOIP 7 KL AZFEHTS
VERH Y £,

\)

B 7—dx, 794~ 2=y bEER I TAH
DA DT RUANKETT, TD .17 R
VAFAA L ZFTAZIPT RLATHY , BED
TIA4=Y 2=y FOHLOTT,

5. VI AZIBMT DL EN—RFNRT FLATBEES L, oG TEMTE X
TO

. ASAY S R4



| Asas 524

ATy
ATvT2

ATvT3

ATvT4

BAA L 8—T x4 20%E EE -7/ 22 [

FIE

[Configuration] > [Device Setup] > [Interface Settings] > [Interfaces] ~X1 > RN L £,
AP =T 2 A ZT2ERLT, [Bdit] 227 Vv 7 LET, A F =T =2 ADNT A =L %
RELET, ROTA RTA L EBZRLTIZIN,

« (A% K EtherChannel €— ROEHA V' H—7 = A ATEHMHAE) [ZDA L H—T = A
A ZEBBAIZT 5 (Dedicate this interface to managementonly) ] : A > ¥ —7 = A A%
BEMAE-NIRELTI 774 vy 7 BBELARVWESICLET, 7740 T, ER
BATDA L EZ—T oA AFEHHEHE L TRESNET, FT AT L ME—RT
X, Zoawy RIZEHEY A TOA 2 —T =4 XL THIZA R—T VT30 £,

s [Use Static IP] : DHCP & PPPoE (X% A — I FEH A,

IPvd 7 5 AZIP 7 —)L. MACT RL A 7F—L. BLOYA FIIOMACT KL 2EBNT 5

Iz

a)

b)
<)

d)

I%. [Advanced] ¥ 7% 7 U v 27 LT, [ASACluster]| =V 7 RTA—X EFHELET,

[IP Address Pool] 7 4 —/V ROFIZHD [ AR &7 Vw7 LTI FAXIP 7—NLEE
e LET, #RINDEREMIT. [General] ¥ 7 CHETDHAA L IPT KL AIZXK YR
ELET,

[Add] 7 Vv 7 LET,

AL I FGAZDIPT RLRAEEERNT RUVARHEZRELET, *vy NT—ZAT
BEMH SN TS T FLAbEHREEA, @I, 7228 T FLXLwnd K oiz,
I 7 AL DY A RZEOETHRICRELSTOILENR D £7,

ano0 Add IPv4 Pool
Name: inside_poaol
Starting IP Address: | 192.168.1.2 D
Ending IP Address: | 192.168.1.9 [_]

Subnet Mask: 255.255.255.04 I

Help Cancel OK |

He4

[OK] %227 Vw27 LT, HrLOS—LZElk L £,
TERC L7280 LW — L &38R LT, [Assign]Z7 U v 27 L, WIZ[OK] &2 U v 7 LET,

7 — L4473 [IP Address Pool] 7 « — /L RIZR/RSNLET,

EE) A7y av) MACT RLRAETFEITHRET H%HE 1L, [MAC Address Pool] %
RELET

IPv6 7 RV AZRET HITIE, [IPV6) ¥ 757 U w7 LET,

a)
b)

[Enable IPV6] F = v 7 Ry 7 A4 N2 LET,
[Interface IPv6 Addresses] =V 7 T, [Add] 27 VU v 7 LET,

[Enable address autoconfiguration] 47" = AR — SN F A,

ASAY S R4 .
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. Z /%> K EtherChannel D% 5E

[Add IPv6 Address for Interface] % 4 7 2 7R v 7 ANEKRSIVET,

c) [Address/Prefix Length] 7 4 —/L RIZ, 72— L IPv6 7 RL AL IPV6 V7 4 v 7 AD
ESZANLET, 72&21E, 12001:0DB8::BA98:0:3210/48] DL HIZAHLET,

d) [LARFrEZV I LT, JIARAXIP S —NVEHRELET,

e) [Add| %7V v 7 LET,

ano Add IPvE Pool
Name: inside_ipwt_pool
Starting IP Address: 2001:DES::1002 =
Prefix Length: 32

Number of Addresses: SI

Help Cancel | OK

f) T—AOBBIPT FLA (Ry NU—2 FLT 4oV R) | LT 497 RAE, 7T RL
AR ELET,

g [OK]%7 YUy 7 LT, LW —E2ERLET,

h) fERE L7728 LW — V&R LT, [Assign]| 27 Vv 7 L, RICOK]ZZ7 Vv 7 LET,

[ASA Cluster IP Pool] 7 4 —/V RIZ 7 — A NFEREINET,
i) [OK]%Z27VUvyZ7 LET,

ATw 75 [OK] %7 U > 7 LT, [Interfaces] <A VIZFRY £7°,
ATy 76 [#H (Apply) 157V v 7 LET,

Z 7% K EtherChannel D& 5E
2% K EtherChannel 1Z, 7 7 AZHNDOTXTD ASAIZJEND D TEH Y . EtherChannel DHEf
fED—¥pL L Tr— RT3 T HTHIZENTEET,
1R BHHIIZ
o 2% K EtherChannel f > Z —7 = A A EF— RNIZTAHALENH Y £,

e NTF aArTHALN T—ROBEAE, ZOFEE VAT LFETAR—ZATHBLET,
FLEVAT A a7 4 F2b—Tay ET— RIA> TWRWEAEIEX, [Configuration] >
[Device List] ™A > T, 77T A4 T72T /A ADIPT RLAD FIZdH 5 [System] & ¥ 7 /L
7w LET,

s FTUART LU R = FROBEAE, 7V v IN—T%RELET, 7V v URIEA
VH—=TxA A (BVD) OREESBLTIIZIN,

* EtherChannel |Z 13 KEB L O/ D Y 7 $ia45E L7\ T< 72 &V, EtherChannel ™ ¢
KEIOERNOY v 7 EOIREX, ASAE AL v TFOELBIZBWTHITORNI & &2
[BLFET, INOEEATIMNENDDILEIE. WROBIIEE L TLEE,

. ASAY S R4
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ATy T

ATy T2

ATvT3

R8> K EtherChannel D% E .

cASA FTHREEND Y 7 OBRKREIZ., 7T AZEIKOT 75 4 7 R— F DO
T, AA v F ETHREISNTZRERY V7 HOMEN., ASA TOEEZEZ TWRNT &
FHERLTL 722,

s ASA ETCEHRESINDIH/NY VI EIE, A= TF ¥y RNV A F—T oA ABLENT D
72O DEINT 7T 4 T R—M g (2=v bHT=V) T, AA v F ETiE, &NV~
IBIT T T AZBEORNY I THDTmD, TOfEIZASA TOESIT—HLE
A,

T T AN MDA —RKRZ U TN ALEEFLRNTLIEE N, A1 v F Tl
7L X . source-dest-ip % 7213 source-dest-ip-port (Cisco Nexus OS 33 & O Cisco I0S
@ port-channel load-balance =~ > R &) Z#fHT L2 L 2B LET, 7 T7X%
WD ASA~D FT 7 4 v 7 BEEICGBEINRLRDIEND LI, m— KT
Y TNAAY ALTE, vlan ¥F—U— FEEH LN T 7230,

o Z/% R EtherChannel il L CWAHE, 7T AX ) VI RERIZA F—T MR DE
T, R—FTFxFNV A F—T oA AFEFBLEFA, TOBHICLY, FTAXDOT
T AT TR =y NI NTF T 4 v 7 BEBESNDONRERINET,

FIE

aATFFARNET—RICEoTKRD LS ICRAEY £7,

o« UV E— ROEE, [Configuration] > [Device Setup] > [Interface Settings] > [Interfaces] 2
AR ET,

s 2T E— ROFE, VAT AFITAA—RXT, [Configuration] > [Context Management] >
[Interfaces] ~A > ZHR L £ 7,

[Add] > [Ether Channel Interface] DJIEIZEER L E 7,
[Add EtherChannel Interface] %A 7 2 778 v 7 ANREKRINVET,

WA X —T M LET,
* [Port Channel I1D]
* [Span Ether Channel acrossthe ASA cluster]

« [EnableInterface] (57 #+ /v b TAH TR £9)

+ [Members in Group] : [Members in Group] UV A hMZ, 4 > X —T = A A%V LH 1218
MT2MERHY £T, 2=y T EITHIEDA > % —7 = A A7) EtherChannel IZ75 F 41
TWbH e, VSS E720E vPC DAL v FICHERe T 25 BIE b E T, 7 7 44 M Tl
I ITABDERAVNTRRIGEDT 77 4T A B =Tz A ADH B AN R
EtherChannel 3MEH TX 2 DI 8T THH Z LITHERELTLEIV, RV DA X —
T2 AFY I REREDIZDDAL L NATT, SELVEL DT VT 47 4 HF—
T A RAEFERTHINE (R LAZ AL A —T = ATIF L) XA TFTIv7
R—=NTIFGAF VT 42T 4 2—TNMILET, ¥A4FT IV I A= TIA4F VT 4%
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AsAY 524 |
. Z /%> K EtherChannel D% 5E

TAE—=TNITDE, VITRXBIKRTRRNRBEOT 77407 Vo7 A TEET,
72 2E, I6BEDASAMNBRD 7 T AXDEAIT., %5 ASA THRR2EHOA L F—T = A4
2 EMFHTE, A3 R EtherChannel D&EHI 2 A v Z—T A4 A0 £,

TRTCDOAS L H =T oA ANFE LA T ERETHD LI LET, BHNGEMT B A1
H—7T7 = A RZ L o> T, EtherChannel D% A 7L HENIED F9, —FHELABWNA L F—
Tz AREBMTDHE, Z2OA U H—T A AXEILKREEIZ/Z2 Y £9, ASDM TlE, —#
L7aWnA X —T = A4 ZADEBIMIBHIESNE A,

COBEEDEY DT 4 —/V NiX, ZOFIEHOBZE-THALET,

ATvT4 (FTvay) TRTCOAUN— A E =T 2 A AIONWT, AT 4T A7, ZEiBE.
WA, Te—floR—X 7 L —Ah% EEX T 5ITIE, [Configure Hardware Properties] 7 U >
JLET, INHDONRTA—=ZITF XY RNV T N—TDTXTCDA 2 H—T = AT LT
HZMENRD DT, ZTOFEEIINGDNRTA—=RE2FETH a— by M ET,

[OK] %7 U v 7 L T [Hardware Properties] D %5 1} AivE T,

ATYTE5 MACT RLABIOAT v a v "I RA—FEFRET HIT1E, [Advanced] ¥ 7227 U v 7 LE
D

* [MAC Address Cloning] f83% C. EtherChannel ® F#)2 27— 3L MAC 7 RL A% E L E

Ty AFZUNAL MACT RLZZRELARNWTL SN, BRENES, BENSRR Y B
U — 7 OEGREA A 5 72912, A3 K EtherChannel 12132 2 —/3L MAC 7 K b
AEBETAHAVNENRHY ET, MACT RLUANFEEBREINTWDLEAE. £D MAC T
RUAEBEORE2 =y MIBED £F, MACT RLAZEE L TWaWEAEIZ, il
Ha=y FREEINELZE, LW =y MIA v F—T = A ATEH LV MAC 7
RURZEHLES, iUk, —FRxry NU—7 OEIEDRBET HRREMENRH Y
9,

VNN FaALTEFARNE—RTIE, aVTHRAMNIITA Vv F—T7 = A 252 EHETHHE1T.
MAC 7 RLZAOHBEVAERZANZL T, FEITMAC T RLRAZRELZRS TTe LD
WLET, A F—T oA ZADOGEIL, ZOa~v U FEZEHLTMACT RL A%
FETRETHLENDD Z LITHEE L TLEE,

=T v RE—F) ¥4 "EZ T 2EZ VY 7 O4 . [ASA Cluster] fHI T, ¥4 FE
AOMACT7 RLRABIUIP Y RLAZRET H7-DIZ, [Add] %27 U >y 7 LT, ¥A K
ID(1~8 OMACT RLABIORIP T FLAZEELET, K8 OD¥ A FT LI
DOFIEE#VELET, A FEAFDOIP T KL A, Za— ULIP T KLALRELEUYT
Xy b REZHAIMERHY ES, 2=y NCHEHT LY A NEAFDMACT FLABIW
IP7 FLRAGF, 2=y hOT—F AR Ty T ar7 4 Xalb—a B ELLEYA
MIDIZL - THERY £,

(A7 a>) VSS £721EVvPC D2 BEDAA v FIT ASA Z 44t 9 554 1L, [Enable load
balancing between switch pairs in VSS or vPC mode] = v 7 AR v 7 A% A2 LT, VSS
=R NG T A X =T VT HRERHY £T, ZOREEZHEHNT L. ASA
& VSS (£721F vPC) X7 L OROWIRY > 7 Bt DA EFI IS I E T,

[Member Interface Configuration] fE3C, 1 72X 2D EL LD AL v FITHEDA > ¥ —
T oA AEPHRT DI ERET O MENDH Y 7,
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ATvT6

ATy T1

ATvT8
ATvT9

ATy 710

ATy TN
ATvT12

ATy 713

R8> K EtherChannel D% E .

GE)  [Minimum Active Members] & [Maximum Active Members] 13i%E L7722 & 2 fELE L &
R

(7> a) Z O EtherChannel (Z VLAN 7 4 ¥ —T7 = f A&FHELET, ZOFIED

B OEE, Y TA =T AZHEHSINET,

(FVF ar7HZX L E—F) ZOFHZTETTLHRIC, 2 TFAMA I —T AR

ZEID Y THLERDY £,

a) [OK] %27 Vw7 LTERNELZMELET,

by £ X —T A AEEIN L TET,

c) —W—DEETHALTHFAMNEETLET, [Device List] XA T, 77T 47727
NAZDIPT RVADTZHDHALTHRAMNEZT TNV Y v LET,

d) [Configuration] > [Device Setup] > [Interface Settings] > [Interfaces] <A > Zi®IN L, WA F~
ARXFTHR—=RNTF XY RN A F—T A AZRIRNLT, [Edit)| 27 Vv 27 LET,

[Edit Interface] 4 7 2 V7R v 7 ANRERINET,

[Generall| # 7% 7 V) v 7 LET,

(hZ AT L b E—F) [BridgeGroup] KR v FHZ T UARIMNSL, ZDOA L HF—T =
ARZEFNOYBTEHT ) v TV —TEERLET,

[Interface Name] 7 « —/V RIZ, 4Ri% 48 LFELUNTATI LET,

[Security level] 7 4 —/L RIZ, 0 (&IK) ~ 100 (Fm) OV~ Li A LET,

(L—7 v RE—NK) IPv4 7 R L RIZ% LT [Use StaticIP] A7 va v K& %7 U v L,
IPBIO~AZ & AN LET, DHCP & PPPoE (IH AR — hIhEHA, KA PV =K1
MEGROSE, 31 By hOY TRy b= A7 (255255.255.254) e ETEET, ZOHA.
Xy FNT—2 F£72137 0 —RFEx 2 F 7 RLAHOIP 7 LRI TFRENEEA, FT %
N7 L b F— ROEAIL, EtherChannel 1 % —7 = A ATIERL, TV v I—7F 4
VHE—T 2 A ADIPT RLAEZHELET,

=7 RE—NR) IPv6 7 RVRAERRET DHITIE, [IPV6] ¥ 757 U v 7 LET,

N7 VAT Lk = ROYAIE, EtherChannel f > % —7 = A AT, 7V v¥ 7
N—T A B =T 2 A ADIPT RLAZHFELET,

a) [Enable IPv6] F = v 7Ry 7 A& F T LET,

b) [Interface IPv6 Addresses] =V 7 C, [Add]| &2 U v 27 LET,

[Add IPv6 Address for Interface] ¥ A 7 2 V7R v 7 ANMFRIINET,
(G¥)  [Enable address autoconfiguration] 47> = i3 A — F I FEHA,

¢) [Address/Prefix Length] 7  —/L RIZ, 72— L IPv6 7 RL AL IPV6 V7 4 v 7 AD
EI&# AN LET, 72& 21, 2001:DB8::BA98:0:3210/64,

d FFvay) FARNT RLAELTModified EUL-64 1 > % —7 = A A ID 23 %1
1L, [EUL64] T = v 7 Ry 7 A% AN LET, ZOAETE, BT [Address/Prefix Length]
TA—=IVRZT VT 4w 7 A ATTLET,

e) [OK]#27 Vv LET,
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B =amty - FEBRLEY SRS OERELZSM

ATv 714 [OK] %27 VY v 7 LT, [Interfaces] W& IZFEY £,
ATv 715 [Applyl 27V v LET,

BEAANY 4 F— REGA LY 52 OEREESM

77257\?@%/%%75‘7725 WZEMT5I1I2iE, 77— FA N7 v FREDPLETT,  (FHlHE
— KiZ72%) 1 £ /— K T High Availability and Scalability ™7 ¢ ¥ — F&ZFIT L Tr 7 A
ﬁ%@ﬁb\?~§/~F%ﬁmbi?o

\}

GE) I — FIZk LT, cLACP VA5 L ID BLOMEBENEN DT 7 4V N2 EETIHE, 74
P—RFIEACTET, 77 AXEZFETRETIDLERDH Y £9°,

1R BRI
ewNF AT HEARNEFT—RTIE, VAT LFETAR—ZATROFIELZETLET, £/
VAT ary7 4 Xal— gy ET— FIZA>TWRWESA, [Configuration] > [Device
List] XA T, 77T 4 TRTNNAADIPT FLADFIZH S [System]| X 77 1 v
7 LET,
« VT AHFIEY 7 ODMTU ZE KD IIISIZFHRTET HZ E2HR L F9, FD=DIZix
COFIEEEETDENCE ) — R T R L — AT EENCTEILERDY F9,
VxR 7 L—LADFHICIE, ASA DY m— RONNETE,
VT ARKKNIEY T A H—T 2 AMERT DA H—T oA AL, RSN AL v
FTT v FREBIZ > TWAMERH Y 17,
BN DY T AR ) — REBINT S L, —BMIC, REMR N7y MR R o v 7 )N
RETHIENBY ETN, ZHITHEENOELETT,

FIE

25w 71 [Wizards > [High Availability and Scalability Wizard] OIFIER L3, kOFIETZ 0@ ¢
P—ROHTA FTA L EMHERLTITEEN,
AT 72 [Interfaces] Hi[fi /> 5 13 L V> EtherChannel Z{EfX T £HA (7 7 AXHIHY o7 Z25x<)
AT 73 [ASA Cluster Configuration] [ T, 7 —hA N7 v 7 OREEHER L ET,
o [A 2 AN—OEFENARL (Member Priority) ] : il — FEEMIZ, 2D/ — FOBSEIAN
Z 1~ 100 OFFHANTHRE LE T, 1 B OmBENERN T,

ﬂ(w~?yF%—F\XNVFBmmMmd%~°)#4F4V?/?X(mwmmmﬁ
Spanned EtherChannel mode) Site Index) |: ¥4 ~NHZ Z A XV o T E2EHT 2581E. 2
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D) —KROY A PIDEHRELT, ¥4 FEEOMACT FL 2 (1~8) BWMEFAIND X
IZLET,

(A7 ay) [HAF— (SharedKey) |: 7 7 AXHHY > 7 OHIEI N T 7 1 > 7 DR
TR —ERELET, HEMEIL. 1~ 63 XFD ASCH UFHITY, HHMEIX, K5
X—%ARTDHDIHERHEINET, ZONRTA—=FE, T—HFNRANT T 4 v T (FEkt
KRBT » 77— MR EIND NNy b L) [T EBELEYA, T—F XA NT T4y
71, W7 VT TFARNELTEFEENET, XAT— ROK L —E A% A X—7
JMIZTBGEICH, ZONRNT A= ERETHILERD Y 7,

(A7 =3 ) [Enable connection rebalancing for TCP traffic across all the ASAs in the cluster] :
B OB\ E A RX—T M LET, ZONRTA=ZIIT 74V FTET 4 8—7 I

o TWET, A RX—TNLDOHFAIL, 7T AXO ASA ITEMICAMIEREZHL, A
TGOS TND T INA ANDATGDODIRNT S AT LW EERta 47 n— FLET,

AR E ST DHEMEEZ . 1~ 360 DOFHANTIHELET, ZORTA=ZF, 77—
FNARZ v THREO—EBTIIRL, ) — Ko7 —% 7 — RicERShET,

GE) A M FARE IS LSRR OBF DM ERE LW TLLEEN, 501
Dy T AR AN EE B TE YA,

(FFar) [VFTAZNDZDT AL ADNVAE=L Y T HAWNCT % (Enable
health monitoring of this device within the cluster) ]: 7 7 A% J — R~V A F = v 7 HEHE
EPZLET, /) — RONVAZRERT DI, ASADY T AL ) — Rix7 T A XY
VI TD ) — RiZN—FE— K Ayt —YEFEFELET, /— FRREERNICET
= RhbNA— =M Ao tE—UEZELRWGESE, ZOET /) — NUNERREEIT
Ty kgL R IhET,

GE) oD MReYEFRETIEEX (L2 T—FA X —T A4 ZADEME
7ITHIE. ASAETIIAAL v F EDA v B —T 2 A ZADA X—T WL ETITT 4
=7k, VSSELIXVPCEEALT DAL v FOBEMRE) X, ~VAF
T A4B—TMIL, T4E—TNILIEA v =T =2f ADE=HX ) T
TAE—TNMITHILERHYET, PABTOEENRET LT, HEOEEN
TRTCO/ — RSN, ~"NAF v 7 EHEANCTEET,

o [TRA ANEEIRRETS L R &N 5 F TORMERE  (Time to Wait Before Device
ConsideredFailed) ]: ZOfEIX, /— ROF—T T I7A4 T AT —HZ A A vE—V DM
fRafEE LET, ®HIX03 ~458TT, 7744 MNI3HTT,

« (A7 =3 ) [Broadcast keepalive messages to all EtherChannel cluster control link ports
for VSS/VPC support] : 7 7 A X {filffl Y > 7 73 EtherChannel & L Ca%E S TWT (i
$F) | VSS L vPC NTICHERE SN TV DAL, 24T va vk A x—T L
(2D 2 ENBBEIIRDGENRDHY £T, —HDAAL »F TiEL, VSSWPC D 1 DD
=Ry N UERRITEBIT S L £ DA A FITHEE S 4172 EtherChannel
AUN—=A B =T 2 A AP ASAIZKH LTCT v 7RETHDH L OICRZETRN, 2
NoDA L F =T 2 A AFIAL vy FRDO T 7 4 v 7 %@ L TWEE A, ASAholdtime
timeout Z {K\ Vi (0.8 7072 &) IR E L7284, ASADNNIR- T/ 7 A X IMLHIBRE L
LHAREMEN D D . ASAIFN—FE—F A v E—T% 26DV T§17 D EtherChannel
AVE =T A RAZERELET, ZOFTvark A x—TNITDHE, ASAILY 7
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B sarus v—FEERLEY SR8 OERERESM

A ZEIEY > 7 DFTO EtherChannel f > Z—7 = A AT/N—hE— K A v tE—
7T 9T 407 LT, DR EBIBDAL v TFRENEZIETEDLZ E&2MERL
F9,

s (AFvav) [ary— 1V hEEET S (Replicate console output) ]: 7 —& J — Kin»
HHlE ) — R~y — AR A LET, ZOMEEIZT 7 40 b CEICHRE S
NWTWET, ASAIE, FEEDEKRA RV MR ELZE X, AvE—VhkEEa Y —
MIHNTHHERHY T, ar Yy —VEREEMHTHE, T—4% /7 — Kbl

J—RiZaryy—nNRAyvt—UNEEENDLIDOT, TE=XTIHMLERHLDIET T AXZD
Y= )VR— M1OFETFTT, ZONRT A= E, T—FA LT v TEEDO—HETIEA
<, il — Ko7 —42 7 — RicERsnET,

* [Cluster Control Link] : 7 7 AZ {7 4 2 —T =4 AZHEELET,

¢ [MTU] : 7 ZAZHIHY 7 A B2 —T 2 ADKRIGE ) — RERELET, T—
BAE—=T 2 A ZADHFRRKMTU L0 D7 &1 100 234 FEME (1400 ~ 9198 /N
A4 boO#HE) ZEELET, T 74/ bOMTIUIZ1500/%4 F T, TIZ¥ v R
T =D TRIEARNNILTWAGAIL, MTU R REICRET S Z & 2 H#5E L
T, JITRAEFIEY I DNT T 4w TIUET —E Ny MrENEGENDL T, 7
TALHNEY LT — Ny NEIEOY A RZIMATI TAZ NT T 4T D
A==y RIZHHIETH2HERH Y £7, =& 20FE, AMTUIL9198 /314 h T
DD, T—HFA L H—T A ADHRKMTUIL098Z720, 7 T AXHIHY >
WX 9198 ICRETEET, F: VY AR T7L—2DTHEANT L TORNES
. YA P—RERTL, Py B 7L—rx G LThE, ZOFIEEZHERT S
VENH Y F77,

AT Tl [~"NAE=HY) U THBEDA L H—T = A A (Interfaces for Health Monitoring) ] [ T, —#B

ATy TH

DA B—=T A AZEEDE=F Y L IRENOERINTE LT, ez, BHA 52—
T A Alp L MWHUNDA B =T 2 A ADNNAET=ZZ Y T H2T 48 —TMTTHI L
MNTEFET, ASAFirepower T2 — V72 EON— KU 2T a— )L EET=HF U o TxtEhn
ST DI, [P—ERAED2a—NVET TAXD~NNVAE=H Y T NEERNT D (Exempt
Service Module from Cluster health monitoring) | F = v 7 AR v 7 A& A N2 LET,

GH) M0 MERVEEEITI L& (RL2IE, F—F AV —7 = A ZAOEMEFIE
Bk, ASAEIZAA v TF LA 2 —T 2 ZADA X —TMLETITT 4 B—T
b, VSS E-IZVPC AT D AL v FOBMAE L) 1X, ~MAF =y 75T 48—
T, TAE—T MLV E =T 2 A ADE=F Y T HT 4 =TT
HZVERHDET, FPAEPOETENET LT, BEOEENTTO /) — RIZFEH]
ENTDH, ~AF = v EREADCTEET,

[ % —7 = AHEFERAE (Interface Auto Rejoin settings) | [T, A > ¥ —7 = A A
FZ7 7 A2 Y 7 TREPEELLGEOBHHEERELZ N AL ~A ALET, Z
AT, ROAT v a v ERETEET,

* [Maximum Rejoin Attempts] : 27 7 A & ~DfER OFATEIE 2 EFK T 5 72DIZ, [Unlimited]
FT72IL 0~ 65535 OHIPFATHEARELET, OIFHBHFHEGET A E—7 M LET, 7
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BEIRAMY < ¥— RE@EALEY S 2ankrErEsm ]

TV MEIE, 7 TAE A B —T 2 A ADOEAT [Unlimited], ¥—4% A >4 —7 = A
ADEEIL3 T,

* [Rejoin Interval] : A ATHBOREZ EFRT D722, 2 ~ 60 OFIPH CHIMREAE R E L
9, T7ANMEXS D TY, 77 AX~OHESME / — RBNRITT DK E G
(X, Eth OFEFRAERND 14400 4y (10 B) IZHIR S E T,

* [Interval Variation] : 1 ~ 3 OFiH TRE L T, MRZEMSELNE I ERLET
(1: %L, 2: HATORRO 2%, 3: ERIOMBD 3 £5) . =& 2%, MRE 5o
WCRRE L. B0 % 2ICRE LTEGEIEL. &MOBATN 5 5%, 2 BIHORITH 10 5% (2
x5) . 3MEHORITN 200% 2x10) RV ET, T7ANMEIE, FTAXA U H—
T2 A ADBEAIT L, T—H A F—T 2 ADEAT 2 TT,

AT 76 [Finish) #2727 LET,
AT ASAIZEfT L 74 Xal—ar a2 Ay LT, 2T AZ Y 35 L TW R WEEEED

ATvT8

FHEMa~ ROFEEZFH~NET, 7740 har 74 Xal—rvailbdravr Ry, 2
NICHEYT 52 ERnBY F3, AMEORVa~y REHIRT HICIZ[0K] 227 Y v 7 LET,
[Cancel] 7 Vw7 35L, 7TAZY U TIFAX—T NI 0 FH A,

LITHLT5E, ASDMINY T AR A 3 —T M LT ASAICHEER L. ASANRNZ 5 AZ|T
BIENzZ & %2879 % [Information] BT 23K /R S ET,

(B BEICLoTUL, VAP —FDORETRICZ FAXIIBIMULIEBRIC=T =B 8ET 57

REMENH Y £7, ASDM BUIKF ST 5 & ASDM IZZEHTHi< =T —% ASA >
OZELERA, ASDMICHERE LB b7 TAX D IR T 4 B—T7 VOYATX,
ASA Y — )L AR— NMIEERHIL T, VT AZ VT RT 4 B—T /Wl > TV Dt
M2z T — AW T 20BN H Y £3, eI, ZTAXGIHY o nE T
LTCWAHAREMENRSH D 7,

T—48 ) — F&BEMNT 212, [T (Yes) 1227 Vv 7 LET,

) — Rovb 7 = REFETT L8568, V4V — REEMICRBET 2L EIC[7 T A%
WZBID A > 3—%5813 % (Add another member to the cluster) | 47 v a3 » # IR L TF —#
J—RZEBENTXET,

AT 79 [Deployment Options] f83k T, YK [Deploy By] 47> 2 > OWFnZi@IR L E7,

[4F<YE—Fz=y MICLIZ~¥ > RZ#ET 2 (Sending CLI commands to the remote
unitnow) ]: 7 — MR NI v TR EET —H /— K (—KF) HELIP 7 FLAZHELE
T, T—H /) —REHIPT RLA, 2—W—4, R"RAT—KEAHLET,

s[EkESNTZCLla~vy REFETat— LT, VE— b=y MY 11T 5 (Copying
generated CLI commands to paste on the remote unit manually) ]: 7 —4% /— K@ CLI T2~
YREDY NT U RR—=RA R T&E5, £/ ASDM @ CLI Y — L& fHTE 5 L9 Ic=
~ Y R#&ARK L EF, [Commandsto Deploy] R v 7 AT, % THHTL-dDa~vy N

BN L Cav—LFE7,

ASAY S R4 .
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Deployment Options

Deploy By: | Copying generated CLI commands to paste on the remote unit manually

Commands to Deploy:

cluster interface=mode spanned force
clear configure cluster
interface GigabitEthernet(/4
no shutdown
cluster group clusterl
local-unit asall
priarity 2
cluster-interface GigabitEthernet0/4 ip 192.168.5.2 255.255.255.0
key test
enable as-slave noconfirm

DIRBVITEHEDHAREZTAX

JTGABZY T VAT = 7 TCP EEfpERMOBIE, 7u—0FE U T ¢, ok
WikE AR~ A A TEET,

i —

R TCROFIRZFATLET,

ASA U S R B DEKXRING A —F DERTE

HfH ) — R ED I FAZEREEINASARXTEET, I TAZ~D /) — ROBINZY 4 —
REFERLZWGAIX, 7 7AXNRNTG A= FETRECEET, T ZAXY IR
AX—=TNTHIUL, W DDDT TAK RT AR ERETEET, JTAXV U THRA
X =T M5 TV HITRETE WL DIE, LA/ FRaEnET, ZOFIEICE, ¥«
P—RIZEENTWRWEER T A= L EFENET,

1R BHHIIZ

AsAY 524 |

s U4 W= REFAET, FEITY 7 AZIIBMT AL, 77 AXIISNT DRI, &
J)—RTUITRAZEBY I A B —T oA AEHFRETALERHY FT, 7L

A H—=T 2 A ADEE, A F—TNMZTEHELENRHY £, o

PAERL L2V T L

72 &V, EtherChannel A v % —7 = A ADEHEIL. A Fx—7 /M LT, EtherChannel €—
KEFNBEELET,

e NTFAUTHFARME—RTHE, §ilffl /) — N EDOT AT LAFITAR—=ATROFNAZ FAT

LET, FEVATL a7 40 FXalb— gy T— RICAS>TWARNWES,

[Configuration] > [DeviceList] XA > C, 77T A TRT A ADIPT RKLAD FIZH D
[System] Z X 727V v 7 LET,

. ASAY S R4
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FIE

AT w71 [Configuration] > [Device Management] > [High Availability and Scalability] > [ASA Cluster] D JI&
(IR L £

T T TAZIZT A APRBEIMSATNT, ZRRHEE ) — ROBEIE, ZO_A X7
7 AHFTE (Cluster Configuration) | % 712HV £,

AT w 72 [Configure ASA cluster settings] = v 7R v 7 A& AN LET,

T IRy I RA%A 71T HE, REDHEINET, NTA—FORENTXTETTDH
% T, [Participate in ASA cluster] &4 N2 L72WVTL 72 &0,

G¥) TIGABEN) T A F—T W LTz, [Configure ASA cluster settings] 7= > 7 7R
I A%F 7T oHmAIE. MREICEMLIZ) A TIT-oTLESV, £7I2T5
LT RTDIFTAZ avy T 4Falb—a N7 U7 &, ASDM Dk ST
WOHEBA V=T A A FZHTRXRTOA U F—T A ATy T LE
T, ZOBE, BREETT ST, 2 Y= K= TCLIICT 7B AT H0E
BHYET,

ATYT3I ROT— b AT T NRTA=HERELET,

* [Cluster Name] : 7 7 A X\ ZARTZAHT £, 40T 1 ~ 38 305D ASCI L FHITH D =
EMMETYT, /) RIELICRETEDZ TAFXZIIDET T, JI7AZDTRTDA
UANE CARTEEHT 208N B D £,

* [Member Name] : 2D 7 7 A K A U NDEAF D4HTE 1 ~ 38 3CF0 ASCI LFHTHE
LET,

o [A U N—DENARL (Member Priority) | : #lf#l /) — N®EMHIZ, Z D/ — KOESLNARL
Z 1~ 100 OFEFANTHE LET, 1 D OESEIEL T,

o[ Ob—7 v KE— K, A/\2 REtherChannel€— R) A hA 27 v 7 A ((Routed mode;
Spanned EtherChannel mode) Site Index) ]: %A R~ 27 T 2%V o ZE2EHT 28581%, 2
D/ —RKO¥A MDD EZRELT, I MEADOMACT FL-A (1 ~8) MMEEHEND L
INZLET,

« (A7 = ) [SitePeriodic GARP] : ASA Ti, Gratuitous ARP (GARP) /3% v k&AL
LCAALS v F U T AT TARNT I Fx 2 HITEFOREBIRDET, A FOBEEIA
NAEDR B B EWA NN E ST, 78— UVMAC/IPT RUADGARP b7 7 4 v 7 BNE
AR S vE 9, % A3 K EtherChannel ® / — K&, 4 FMACBLXO'IPT KL
AT LT A NID ZHETDHE, GARP BT 7 4/ N THI/ W £7, GARP [#lFE%
1 ~ 1000000 AR E L ET, 7 7 4/ T 290 B TH,

TIGAIMBIEEEINTYA PTEOMACKEWIP T RLVAE Ty 3V A NEHFH O
MACT7 RLABIOIP T RLAZMHAT DI L, 7 T AKX TZE L7z 37 v M,
7 —/N)VMAC T RLVABIOIP 7T RLAZFEHALET, T 74 v IR 7 a—r3L
MAC 7 R L AL EMICAER SN2 WA, 78—V MACT RLADAA v FT
MAC 7 RLADZ A LT 7 MBBETHAREMENRH D £7, XA LT 7 MRIZZa—
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B ssavs5zx508515 2 —s08E

NMACT RVASND T T 4w IVIRAAL v TF U T AT TARNT I TF v 2Rizbizn 7
ToT AT EN, TRICED AR T —= 2B L0 X2 T 4 LOENRET S
EMNHY FEF,

(A7 a ) [SharedKey] : 7 7 AZHIHY > 7 OFH N T 7 4 v 7 DR F — % 3% E

LEd, HAMEIL. 1~ 63 XFD ASCI X4 T, HAWEIX, HEF—24Akd
LHIDIEHINET, TORTA=FE, T—FNRA NTFT T4y r (BERET v
T— MREEIND Ty M E) I3 BLEYA, T—F XA NTT7 4w 71%, FIZ
VT THRARE LTEEENET, AU — ROEE{bY—E 2% A X—T NI T 58
B, ZORTFRA—FEZRETLHILERH Y 7,

(4732 ) [Enable connection rebalancing for TCP traffic across all the ASAs in the cluster] :

B OB\ E A X—T M LET, ZONRITA=ZIEIT 74V FTET 4 8—7 I
BRoTWET, A X—TNDBFEIE. 7T AZD ASA ITEMICARIEREL SH L, A
TEDODNS TNDT A ANBLARODIRNT A ZH L2 47— K LET,
AR ST DR Z . 1~ 360 BORHNTIREL LT, ZONTA—ZF, 7—
FA BT v TREO—EHTIHRL, Kl — Ko7 —4% 7 — RcERInET,

[Enable cluster load monitor] : 7 7 AX AL ND NT 7 4 v JAMEE=FZ—TEZ5H LT
720 FE LT, JRITIE, BRHEERE. CPUL AEY DR, Ny Ty Fay 7R ERE
FNFET, ANRETEILHE. BOVDO ) — NBAMELBTXAE8IE, / —KDr T
ALY T FETENCT D0, IMNBAAL v FOr— RRT o T RS 50 &
RCTEEF, ZOKRIZT 74V FTAR—T NI TWET, bT 747 DA%
EWMIICE=F—CT&E7, AMNETELHEE. /—NTI 724 7% FE)CE
T D L aBIRTEET,

ROMEZBELET,

s [Timelnterval]: E=%—1U > 7 X vt— U ORER %, 10 ~ 360 PO CRE L
F9, T7ANNI20HTT,

* [ Number Of interval]: ASA 237 — & Z{RFFT D RIFROE A 1 ~ 60 DOHEiFH TRE L £
9, T 74V ML 30 TT,

N7 7 4 v A EFRT HITIE, [Monitoring] > [ASA Cluster] >[Cluster L oad-M onitoring]
LTS IEEN,

(AT a) [VTAZNTIOTNA ADNVAE=Z Y T % H323 % (Enable
health monitoring of this device within the cluster) ]: 7 7 A% / — RO~V AT = v 7 HERE
EHEMIZLT, /J—FK/—hE—h AT =X 2 X vt—VMORMBEREZRELET,
031 HA5FHOMTERTEET, T 74V MI3BTT, F:HLWW —REI TR
WML TWT, ASAEZIFAAL v F D MR URNERINDEHE, 7T AXNERT D
EFTIOBREE —RICT 4 E—7 VML, Tae—T SNl v Z—T = A ADA
VH—T A RF=ZRZ VTS T 4 =TT HRERG D £ (B

(Configuration) 1>[7/\1 REHE (DeviceManagement) |>[N\A 7RAL S EUT a4 ER
—35E 1T 4 (High Availability and Scalability) ] >[ASA%Z 524 (ASA Clugter) | >
[V5ARBZAVA—D A AANLRAEZL ) V45 (Cluger InterfaceHealth Monitoring) 1)
JITABE NRRYOEENET LIzb, ZOWREBEFHEAS R—7MITHIENTEE
T /= RONVAEHRT D720, ASAD Y T AKX ) — RiZ7 7 ALHIEY > 7 Tio

. ASAY S R4
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J—FRliin—btE—h Aob—UEELET, /— FRREEEHNICIET J— Kb
N—FE—=F A=V EZELRVES, TOET ) — NISEREEZITT v RIkEE
LR ENET,

« (A7 =3 ) [Broadcast keepalive messages to all EtherChannel cluster control link ports
for VSS/VPC support] : 77 7 A X itV > 7 73 EtherChannel & L Ca%E I TWT (i
$E) | VSS EILVPC T ICER SN WA EEIEL, oFTvaraf x—T L
IZT D ENBEICRDGENRLY 3, —HOAA v FTiE, VSSVPCD 15D
J—=R3vyy N UFETITEEIT 5 & £ DA A FITHEE S 4172 EtherChannel
AU B =T 2 A AP ASAIZK LTT v RETHD L OICRAETRH, 2
NoDA L Z—=T A AFIAAL Y TFMO T 7 4 v 7 Zd L TOEF A, ASAholdtime
timeout Z KV Ml (0.8 7072 &) ITRRE LT8G, ASANTR- T 7 A ML HIBRE R
LAREMED B D . ASAIIAN— R E—F A v E—T% 26 OV 7O EtherChannel
AVB—=T A RAZEELET, TOFTvarazAX—TMITDHE, ASAIZY T
A B Y > 7 OF T BtherChannel f % —7 = A AT/N—hE—h X vt—¥
7797 4T LT, DR EBLIBDOAL T RENEZ[ETEDHI LR L
£75

« (XFvar) [T/ AWH (Debounce Time) ] : ASA 23A > X —7 = A A& [EEN
FELTWDLERRL, 7T AXMNE ) — FREIBRENDETOT NN AR Z R E L
T, ZOREIZED, A ¥ —T oA ADEEE LV REITHRHTEET, TRV R
R 2 < 5 &, BBREOMREMENREL D Z LICEELTLESY, f ¥ —T =4
ADAT—HATHNEAETDHE, ASAIFA X —T =2 A AEEL L (~v—F L, 77
ABING ) — REHIRT D& THRESNZ I U L £, EtherChannel 234 7 >k
NS T v IRBEBIZBITT 2568 (AL vF B a— K&/, AA v F T EtherChannel
DEMM 2o 1272 ) | TAT AN LD EL 720, =Dy FUZBWTHIO
7T AH ) — ROGINERR =D, JTAX ) —RTA U H—T 2 ADEENREREN
LHIEEBTHZENDHDET, T 74N DT NT U ARER]IL 500 ms T, BRI LED
P IZ 300 ms ~ 9 BT,

(FFvav) [y — ) E#ERT 5 (Replicate console output) | : 77— / — K

SHIE ) — R~y — R ZENC LET, ZOMEEILT 7 41 b TEICHRE S
NCWET, ASAIL, BIEDOEKRA RV MBRELZEXIC, AvE—VZEEa Y —
JNZHT 556050 £, avr Y —VEREEMIT L L. T—% 7 — Ribiil
J—=RIZary—nNRAyvt—UNEEENDLIDT, T=XTHLENRHLIDITT T AZD
V= VR— RO TT, ZONRTA=HF, T—F AT v TEEO—FTIEA
<, W/ — Ko7 —4% ) — RicER S ET,

(A7vay) 95R82)05 g0—EFEYF 454 2—TIIZLET, LISP A A2
73 alOFRTE (50X—=) ZBBL T EE N,

(473 3 ) [Enable Director Localization for inter-DC cluster] : 7 —# &> ¥ —DH% A k
M7 A2 T TRIT =< A% ESHETT U RNy TR OIRIE 2 BHET 5
WX, 747 2=V EB—va kA x—7MILET, @BE, FrLunEsiie—F
NI UAINT, BEDOYA FNDI TAZ AU NR—ZL Vg ENET, 72720, ASA
37 4 V7 ZOEENEAEEDT A FTAUA=IZEIV Y TET, T4 X un—h)E—
Tail kv, BT 4 vy ZEEINA F—T TR0 EF, ZhUuE, fraE s FECY
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A MIFHET 20—V T4 L7 28 AEEDOY A MIRETE 570 —" v T4 L7

ZTY, FiAELT AV 2R UYA MIRET LI LT, N7+ —~v U ANMELE
T Fio, TOFAE TEERRELILSS, v—L T4 L7 23 RUYA FTHL
WEERETA B 2 BINLE3, 7T RAZ A AN=HDOY A FTHA SN TWDERED /N

7y NEZETHIHEE, Ju—L T L7 2RI NET,

(A 7> =3 ) [Site Redundancy] : A FDEENS 7 v —%2RKi#ET 272012, A FD

TEMEFENCCEET, BN\ 7T v I —F =B A4 —F—ERULYA NMIHDGE
I, A FOREEND 7 a—%2R#T 572012, BMONY 7T v 7T A —F—RBRl0H A
FOBBIRENET, T L7 ¥ u—h)EB—Ta g NoOTEMETR A O¥EET
To TDOHIHLD 1 DELFMFERETHIENTEET,

(A7 vay) HRIFAMT 72T L—2 a3 28421 % (Enable config sync
acceleration) ]: 7 —% / — KA/ — K &6 UAERROS G, MRORIZ A% > 7 L,
armat LET, ZOKRIZT 74/ b TA X—T MIR>TWET, T OBRRITA
J— RCTEREIIN, §ilf#l /) — FhbTr—4% /7 — Rl snEwi,

G —HomEa~r NL, 77246 0omEbs BHEERH D FHA, ZRHD
aw R — RIAFIET 256, 7 7 A X EEOREBIERE /2> TN T
b, REORIITFICHELET, 7 7AXBEOmELEBESE DI, A
Bt D 72 WERE BB 2 LN H W £, show cluster infounit-join-acceler ation
incompatible-config Z ] L C, A#MEDRWEELZ R R LET,

« NSRS D LY o — R & AZNTT S (Enable parallel configuration replicate) | : 7 — %

J— FEWAT LU TREERE N FEHLSND Loz, Hill/ —FeAZicLEd, £5 Lk
WE FIRIERICEIT S, ZL<DORRRPND ZERH Y £,

s [Cluster ControlLink] : 77 Z A X il > 7 £ o H—T 2 A AEBELET, ZDA 2 HF—

. ASAY S R4

TxA AE, RESNTWOARTZMEHNTE LA, BHRRA F—T A ZNRF
Ry XYy YR NMIFRRINET,

o [Interface] : £ > % —7 = A AID, TZiUIXEtherChannel #{8E L F T, V741 X —
T A ALEHIAT A F—T oA ATFFAISNER A,

«[IPAddress] : IP7 L A |ZIXIPvAT RLAZ$EELET, IPvold, ZDA % —T =
AATEFYFR—FSNETA,

* [SubnetMask] : 7Ry h v A7 HEELET,

o [MTU] : 7 ZAXHIEHY 7 A B2 —T 2 ADKRIGE ) — RERELET, T—
BALE—=T 2 A ZADHFRRKMTU L0 D72< &1 100 234 RE M (1400 ~ 9198 /N
A4 bOFH) ZELET, T 74/ bOMTUIZ 150034 T, 77 AX{EY
YIDRNTT 4w ZINET =Sy MEENREEND 2D, 7 T AXEHIEY 7%
F—=H Ry NEIROY A RZMZTT TAZNT T 4T DF—r3—~y RIZ %)
ST HMENHY 3, 7T ARG 7 O MTU ZEKEICHET D Z & 2 HilE
LET, 2O1-0I0E, ¥R T7L—LADOTREENCTALERHY ET, Px
VIRTZ L—ADFRINTIE, ASAD Y B— RABRMLETT, 72& 2 iE. mAMTUIL9198
NA RNTHDLIED, T—H A H—T 2 ADFARKMTUIL098 2720, 7 T A Xl
Y 7139198 ICRRETE £3,
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« (A7 =3 ) [Cluster LACP] : A3 R EtherChannel % fl3~% & & (X, ASA X cLACP

L TRAN— A A v F & DO TEtherChannel D% = —3 3 %47\ 9, cLACP
FAL =g VORI, RILZ 7 AFND ASA IZHEWICEEET 2720, A4 v FITiE
120 (HAR) THRAATHLINOEIICRZET,

* [Enable static port priority] : LACP DX A X v 7 R— s T I7AF VT 4 &7 1 &—7
MILET, —BOAAL v TFIEAFTIv I B—hF TI7A4F VT 4P AR—FLT
WRWDT, ZONRTA—=HIZLY AL v FOEEENRM ELET, 512, 8L
D% DT I T 4 772 A K EtherChannel X > /XD IR — M3 A X —T 270 F
T ORK3I2AUN) , ZORTA=FEFHLRNE, PR—FENDDEF8HD
TIT 4T ANESEDAS N A NOBTT, TDONRNTA—H oA x—T
M LTSGR, AZ A AN TEEHA, TRXTOAANT 77 47T
T TONRTRA=FE, T— b A RNT v TREO—EHTIERL, HIH/ — b7 —
2 ) — RIZERENET,

* [Virtual System MAC Address] : MAC 7 RV A TH 5 cLACP v A7 A ID & TE

LET, TXTOASARR LI AT AIDZMEHALET, ZUTdlE, — ik~ T
HBEVEREN (F7408) ( T_XToO®HFY ) —RIcERENE T, HH0T
HHH O TFETRET S 2 b TEET, HiIZl6 By b 16 T, &
ZIE. MAC 7 R " A 00-0C-F1-42-4C-DE /%, 000C.F1424CDE * AJjL %3, Z oD/
FA=HIE, T—=PFART v TEREO—EHTIERL, §lf# /) — b7 —% /—KRIiZ
BRIIXNET, 720, 20X, 7 T7AF ) T BN LT EICORET T
EJr AN

« [System Priority] : 1 ~ 65535 D#PATI AT L FIA AV T 4 R ELET, T4
FVT A EEBREELHY T 5 ) — FOREIHEHNINET, 774/ FTiE, ASA
W7 I7A4FV 741 REDTITAFV T 4) #EHLET, ZOTTA44V T 113,
AL TFDTITAFTVT 4 LD EENT ENRVETT, ZONRNTA—FF, T—F2R
NT o TEEO—ETIIRL, H# ) — Ko7 —% — NcERSET, 272
L, ZOfflL, 72 7AZ Y T EEHNLESGRICORERTEET,

AT w74 [Participate in ASA cluster] = v 7Ry 7 A% A NI LT, 7 7AXIISIMLET,
AT975 [Applyl 227 U v 7 LET,

AVEB—T A RADANIILRA EZA—) V9B L UVBEEBHEDRTE

e xiX, BEHA V=T oA R0, MWEUSNDA L E—T 2 f ADNVAE=H—Y T
BT AT NCTHIENTEET, (EEOR—F Fry 3D, JLEID, H—OWE 1
H—7 A AID, F£72ILASAFirepower £V 2 — V72 EDY 7 Ny =T /INN—R U =27 FY 2 —
NEFT=H—T&FET, ~"NRAE=H =V TIEIVLANY T A U H—T = A A, FT21T VNI
RBVIZR EDRABA  F—T oA ATIFFEITEINERA, 7 T7AZHW) 7 OE=4—1
TIIHETCEEFA, 2OV 7IEFIZE=F—SINTWHET,
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B sz 120 2 2z8—vorBrvEDEREORE

ATy T

ATy T2

ATvT3

ATy T4

FIE

[Configuration] > [Device Management] > [High Availability and Scalability] > [ASA Cluster] >
[Cluster Interface Health Monitoring] DNEIZERIN L F 97,

[Monitored Interfaces] AN 7 A TA »Z —7 = A A% %R L, [Add] %~ U » 27 L T [Unmonitored
Interfaces] N 7 ANZEDA o F—T = A4 A% BE L E7,

AVHE—T 2 ARART—HA XAy E—VIZL>T, Vo I7BEMBENET, FFEOHE
A B—=T 2 A ADTRTOWYHEKR— b2, FFED /) — F ETIIEENEA LA, Blo/ —
REDORI U#HEAA v X —T 2 A ATT VT 4 TR— I RHDLEE. FD ) —Ridr I 2L005
IS nEd, /— RBBR—L REFEINICA V=T 2 A AT —H A A v —V52Z(EL
ROGEIZ, ASAR A U N—% 7 TAZNLHIBRT 5 TORMIEL, A v ¥ —T A ADHA
T, FD ) — RBWENLE A L NTHLD, FITT7 TAZIIBIMLL S ELTWDNIT
Lo THRARVET, 774N ITEH, ~NAF =2y 7 IFTRTOAS U HF—T 2 ATA F—7
T TR o TWET,

ez, BEHA VY —T oA A Y, RWADANDA L F—T 2 A AD~NVAET=H— T
ETA4E—TMITHIENTEET, A—FF 3D ELEID, E2dHE—0WE( v
#—T A AIDEETEEST, ~NRAE=F—U L IVLANY T A v X —T = A %
71X VNI °BVI R EDFEIEA v F—T7 = A4 ATIIFATEINER A, 7 TAZEHMY) > 7 DF
=H =Y U TERETEERA, TV U IEFICE=A—SINTHNET,

SO MR PER (2L 237 %A X —T A ZAOBIHEIEE. ASA F7201XAA v T
oA v —T 24 2O/, VSS £721F vPC BT D A4 » FOEM) #1795
EXZIE, SN AT =y VSRR A NS L ((#ERK (Configuration) 1>[7 /31 XREHE (Device
Management) ]>[ERIAEE R —F EYF 4 (High Availability and Scalability) ]>[ASA%
A% (ASACluster) |) . ML LIZA VX —T =2 ADET=F Y U T H AL TLIES
W, FRBYOEENET LT, REOEENTRTO/ — R snzb, ~VAF =y
JHEREE EA NI TEET,

(IEE) ASAFirePOWER 22— LR EDNN— R =T 713V 7 h I =27 E a2 —L a6
b9 % 121X, [Exempt Service Module from Cluster Health Monitoring] &= v 7 7R v 7 A % 4 /|C
L%,

AVB =T A A, VAT A, FTFT T AZEIY > 7 ICEENEAE LIZGEO BB S
DRREHE I AL <A AT HITIE, [AutoRejoin] ¥ 7227 U w7 LET, &4 A 7B L T[Edit]
7V w7 LCTIROBREZITWVET,

* [Maximum Rejoin Attempts] : 2 7 A ¥ ~DFHfEE OFATREZ EFHK T H72DIZ, [Unlimited]
F720T 0~ 65535 OFEPHCEEZRELE T, OIFHBFEA2T 4 —7 i LET, 7
TANMEIX, 7 TAE A B —T =2 A ADBAE [Unlimited], T—% A > X —7 = A
2B IVY AT AOBEIL[3] T,

* [Rejoin Interval] : FHfE G ATHIROKR 2 E &R D720, 2 ~ 60 OHEIPH CHIMR AR E L
F9, T 74N MEXS D TT, 7T AX~OHESNE / — RBRITT D R KA FHFRH]
(X, EtEOBEEIRAERDD 14400 47 (10 A) IZHIBR S ET,

. ASAY S R4
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* [Interval Variation] : 1 ~ 3 O#i THREL T, HRZEMESELNEINEERLET
(1:Z®RL, 2: EATORMFEO 2%, 3: EATOMBD 3 £5) . =& i3, MExz 55
ICRRE L. B % 2 ICRRE L2 alE. RPIORITN 5 43%. 2 BIHORITHR 10 5% (2
x5) |« 3IBEHORATA 204312 2x10) LRV ET, TTANMEK, FTAX A H—
T2 A ADBEEIT[]. T—F A Z—T 24 ABL RV AT LAOEAIT[2] TT,

T 7 IV FEREIZR T2, [Restore Defaults] #27 U v 7 L¥ 9,

ATy 75 [EH (Apply) 1227V v 7 LET,

7S5 R3 TCP ERDEEDETE

ATy I

TCP 8t D7 7 A X ERDBEIEE FEMEL T, T4 LI XN 7T v 7 7a—EROBIEIC
XD A N7 v —ICBET D TREREE] PR CEET, T4 L7 XN I Ty
T —MERSINDENCZ=y FRKRMT 5613, TNo0 7 —%20ET5Z L3 TX
FHA, RIS, 7 —%2ERT2R1C N T 7 4 v 7 BBlO =y MIHHE SN LA, it
NZEETHZ LT TEETA, TCP DT F MEEENLT S T 7 4 v 7 D TCP DER
DBEZF I LR NE DT EILERLY £,

FIE

[Configuration] > [Device Management] > [High Availability and Scalability] > [ASA Cluster
Replication]. DJIEIZEIN L £,

ATY T2 [Add) 27V v 7 LTROIEZRE L 9,

* [Replication delay] : 1 ~ 15 OFFH THEEZE L E7,
« [HTTP] : X COHTTP v 7 7 ¢ v 7 OBFBEEFZE L £,
* [Source Criteria]
* [Source] : EFTLIP 7 RLAZHELE7,
e [Service] : (A7 ay) HEEXAR—FERELET, BEIL FETLEITSELER—
FOWFNNERET D0, W7 EBICRELEEA,
* [Destination Criteria]
s [Source] : sBJCIP 7 RV AZFHREL T,

e [Service] : (A 7'Ta ) sieAR— FE2FRELET, BHFIX, EEILELITIELEF—
FOWTNPERET D0, ML BICRELEEA,

ATy T3 [OK]Z27 V7 LET,
ATy a4 [Applyl 27 U v 7 LET,

ASAY S R4 .
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YA FEEREDRE

YA M7 T ALV T OGE, WRIELZEEZ®O DT, REEVAI~A ATEE
B

HS5RF 20— FEEYTFLDEFTE

LISPO NI 7 4 w7 2BELT, —_"=0VA "NEZBHTIHFICTu—F T 1 %2F
M TEET,

LISP A A2 2 g DN T
LISP 77 4 v 7 BBBETHZLET, V4 FHOTZ7e—DEE ) T 4 2GR TEET,

LISP {ZDuT

VMware vMotion 72 EDF — 4o ¥ — i~V OFEV T 412> T, =37 747
Vb DG AT S LRI, T A —MEBEITEET, Z0koRT—Ft
Z—=P—=NEEYT 4 &2V R— T2, = "OBEIRFICT— S ~DAJ)— & —
HNHEHTEDHHENH Y 9, Cisco Locator/ID Separation Protocol (LISP) D7 —F7 7 F ¥
X, 734 A ID, DF V=2 RRA 2 MID (BID) #ZDHAT, 2V V—T 47 alr—
% (RLOC) B 20082 F N 7 AR—=R G L, b —_OBIT27 747 b
WXL CEBIICLET, 7m& 2 E, =B LW BEI L, 7 74 7 > b3 —3IC
N7 74w BEETDHE, V—FIIH LW T 70 v 72V XA L7 FLET,

LISP Ci. LISP o/ b ®/ —% (ETR) . AJJ b b—% (ITR) ., 77 —A b
Ry T —4, =7 UYL (MR) . BEIO~y 7T+ — MS) REOHDH —EDT—
B W T—Z L — NPRUETT, = "PRONL—F TR SN TND T &&= —30
Ty —A MKy T NV—=EZRENTHE, FONL—=Z[IMDOTRTONL—F LT —HZX—2 %
FH L, 7747 MIBRINTWDLITRN N7 7 4 v 7 #RITZE LT 7L L, #
LW —ROEMICERFTELHEIICLET,

ASA LISP ®H 7R — |

ASA IZ LISP HIRZIAT L ERH AN, HBITOZEFIZBEATHLISP N7 7 4 v 7 &L, v —
LV RIp 7 FAZY) o TERIEDT-DIZZ OIEREMEH TE EF, LISPOKMEEITHORWGA
P=DBFH LY A MIBETLL, FT T4 v 7307 e—F—F—0RbYIZ, FLw
PA NTASA T T AL A NR—=Z7x0FET, HTLWASADRENYA FOASAIZ N T 7 4 v
JEERE L%, WO ASA L, P ANZRIET LD N T T 4 v 7 EH LT A MZEY
RTHERNHVET, ZTONT 74 v 7 7u—idikETidn, Thvrih—=v7) i
(~NT =07 EMEERET,

LISPHEAIZ LD, ASA 7 T AKX AU N—X, BHIOK v 7 )—4 & ETR £7/2X ITR T
DY SNAHBLISP T 74 v 7R REBEL, 7r—0OFBEELYH LA MIAETX E4,

LISP DA KZ A~

cASA VT AL AUNR—I, VA D77 —A K Fy 7 )L—F L ITR £721% ETR DI
TFELTWALERHY FT, ASA V7 FAX AEEILEE AL v DO T 7 — A MRy
=R T HZEITTEEREA,

. ASAY S R4
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ASA LISP O FEiE

ASALISP D% .

RSB ENE T e —0R R R—FanET, —wmibahizTe— EotsniT
n—, F2EMEAD /) —RIZBL WA 7o — I LA —F—lci@3Bihsntti, ¥
SEENTZ 70— ZIZSIPREDT F ) r—varNEaEnTBy, Slvu—LZzn4~
TOF7ua—RNEL ASAIC K> TS ET,

I TAZFVAYIBLIP4D T —RELZBEH SE L7 TT, —#HO7 7Y r—a
VTR KbND AR H D £,

cFFH O 7 0 —FTIXE VR AR R TRNT B —04, A —F—0OBEIIa H Tk
WHREMERH D 9, AV ART v a R U—%RET D E X, ZOMEETYAR— |
SINDENT T4 DA TEFETEET, £, 7Jr—FEEV T4 ZRAIKRBR T
T4 ZICHIRT 2 HERH D £,

ZOREICIT, BEOMAIZERTIRENPFENTVET (ZALIZONTITTRTIDE
THMHALEY) &

1

(EE) FABNELIIT—NIP 7 RLURIZESSBRAEXNE EID OFIfR : 77 —A h v
T N—HE, ASA 7 T A NG L TWARWKA MERIIRy U —Z |2 EID @A
YtV EFETILENDHV ET, T, 7 ITAXCHEET LY —"FEiIxry b

U —7 OFHZEID ZHIRTEET, 2L 2L, 7 TRAEZNR220H A NOHRIZEHE L TW
D3, LISPR3ODY A R TEITEINTWAGAIL, 77 AZICHEELTWS 20501
MZxF L TOHREID 2 F O 5 5LENRH Y £,

LISP T 7 4w 7 ALV AT g ASAIL, 77— A MKy 7 —4% L ITR 7213
ETR O TE &5 EID WA v —I28BWW T, UDPAR— k4342 O LISP + 5
T4 w7 ERAELET, ASAIL, EID &A1 N ID Z#B8#fHT 5 EID 7 — 7 LV ARFFL £
T, e xE, BAIOBR Yy T NV—FDOHEFEITLIP T R AL ITR £721X ETR O%EET KL
A% HOLISP b7 7 4 v 7 ERETHHLENSHY ET, LISP b7 7 4 v 72T 4 L7
ARFD LB THNTEOT, LISP N7 7 4 v 7 AKIZZ 7 AZREBOILFIZSM LN
LIZEELTLIEEN,

BESNIE NI 74y TCO7u— YT 4 2HMNTHY—ER R — VR
2IVTF 4 AN T T 4w 7 T —FE YT L E2ANTAHAMNERLY ET, -2
X, 7r—EFEE U7 4%, HTTPS N7 7 4 v 7 OHRIZHIR L2V | FFED Y —3 & DI
TRV SND T 7 4 v 7 OBRIZHIRLIZY TEET,

PFA MID:ASAIL, K7 TAX /) — KOV A FIDEFEHLTCH LA —FT—ZRHELE
R

Tua—EFE VT4 EBFNNT DI TAZLVDORE : 7V TAX L THL7r— FE
V7 4 2N T AUNERHYET, ZOF /A 70UV EZ 2T 52T, BED
PITADNT T4 7 ERIIT IV r—y g iixLCr7ue—2 )7 4 2fBEICERE
I ESC TE £,
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B usprozxxsvaone

LISPA > AT g v DRE

ATvT1

ATy T2

LISPO T 7 4 w7 2BELT, h—_"=0VA NEEZBHTIHFICTu—F YT %48
Mz TEET,

1R BHHEIIZ

e ASA 7 T ABZDFEANRT A—FZDHRIE (40 _X—) [>T, HEI/FAF 2=y %
A FIDIWZEY B TET,

cLISPONTF 7 4wV IET ITANNA VAN ay NI T 497 7TFATEENRNT
O, TOFIEO—FHELTLISPDO 77 4 v 7 HIZHDO 7 7 AR ET HHLENH Y F
j‘o

FIE

(fEE) LISPA > AT v ary <~y T EHFELT, IPT FLAZESOTHREF A EID &

flFR L, LISP OFRiHAF—2RELET,

a) [#Rk (Configuration) 1>[Z 74 74—l (Firewal) 1>[A#7>x¥ + (Objects) |>
[#RE~ v 7 (Inspect Maps) | >[LISP]Z##R L £,

b) [Add] %27 Vw27 LT, Ly 7 ZBIMLET,

o) 4l (K40 3X7F) EFHHIEZATLET,

d) Allowed-EID access-list {22V Tld, [Manage] #7 UV v 7 LET,

[ACL Manager] 2358 & £7,

Ty —A LKy T N—FELITITRETR 1L, ASA 7 7 AZBEE L TWRNWAR M
IFX Yy NU—ZIZEIDIBHIA v —VE2EETLZERHVET, 20D, 7 I RAFIC
B 52— N"—F /IRy NU—7 DARICEID Z#HIRCx 9, 7m&ziE, 77 AN
2O0DYA FORIZEE L TWBN, LISPA3 DY A FTIEITENTWHEAIE, 7T
AHZBEE LTS 20084 MIxtLTOREID 2505 LENH Y £,

e) 77 AT UA—INDOERETA RIZHEST, D7 &dH 120 ACE TACL #:BEMMLET,
f) MESUT, WEF—ZF AN LET,
Bt —% a2 — L7%AIE, [Encrypted| v a v A&7 )y 7 LET,
o) [OK] %27V vr LET,
=R RY = — L EZBIMLUTLISP A U AXRT Vg VERELET,
a)  [#R (Configuration) |>[Z 74 72 A—JL (Firewall) |>[Y—EXKRY >—L—)L
(Service Policy Rules) % i#R L &7,
b) [BEM (Add) 1227V yZ7 LET,
c) [Service Policy] —YC, A V' H—T7 = A A~D/V—)LE 2T T 0 — )72 b— )L % il
% Lij‘o

BEEOY—E R EY o—HHT 2 LORBIE. TOEY —T—L a8l %
F. 740 h T, ASA I global_policy &BRIEND 7 m— 3L WY -G EE
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ATvT3

ATy T4

d)

2)
h)
i)
j)

k)

usp 1 vz~ avonzE |

T, RV =27 v —VYUIEHA LR2WGEEE, A X =T =2 AT LI 1 5D%—F
ARY =% ET 52 b TEET, LISPA VAR Vg id, WHFAICRT 7 4w
JICHEMT BT, RETRESEOW T DA Z—T = ZTH—E AR —%EH
TOMEZIDHY A, T T4y I BWGRDO 7 T A —ET 5856, V&
TEIA =T 2 A RAHANVT DT T4 v 7 DT XTREBREXTET,

[Traffic Classification Criteria] ~~—3"C, [Create a new traffic class] &~ U > 7 L. [Traffic
Match Criteria] @ T8¢ [Source and Destination IP Address (uses ACL)|& 4 12 LE T,
Next] 27 U v 27 LET,
AVANRTarETO NI T4 v BIBELEY, Y7 —A M Ay T )L—F L UDP
A= F4342 DITR £72IXETROMIDO N T 7 ¢ v 7 &45E L £ 7, IPvd ACL I L UVIPv6
ACL D EBHHITHME L TNET,

Next] #7 U v 7 LET,

[Rule Actions] 7 « #'— K ~X—F 72 % 7 C, [Protocol Inspection] % 7 % i#&IN L £ 7,
[LISP] F = v/ ARy 7 A%A NI LET,

(A7 a ) [Configure] 27 U 7 LT, AERKLTeA VAT va v~y ThREINL
*7,

[Finish] 227V v 27 LT, #—EZ2 K o — L— L EZRELET,

P—EA R = L—NEZBENMLT, BEERN I 74y 0O 70— )T 028 LFE

B
a)

b)
<)

d)

2
h)

)

)

[#8RL (Configuration) |>[Z 74 72 4—JL (Firewall) ]>[Y—EXKRY >—IL—)L
(Service Policy Rules) 1Z3&#R L %9,

GBI (Add) 1227V v 27 LET,

[Service Policy] “X—"C, LISP A > AT v g ANZFEHT AR LY —ERA R v —% 5

RLET,

[Traffic Classification Criteria] ~X—3""C, [Create a new traffic class] 2 U v 7 L. [Traffic

Match Criteria] @ T [Source and Destination IP Address (uses ACL)]Z 4 2 LE T,

Next] Z#27 U7 LET,

P N—=DY A NEEETDH L ETEERYT A MCHFFHIVYTTH, EORRAZ VT o

ANIENT T4 v 7 HBEELET, I xlE, 7r—FEE VT 4 &Z HTTPS 77 1 v

JBIWERIREDY—N—~D T 7 4 v 7 DHIHIRTEET, IPVvAACL B &

O'IPV6 ACL D EB HIZ R L TWET,

Next] Z#27 U v 27 LET,

[Rule Actions] 7 « ¥'— K ~X— & 7213 % 7 C, [Cluster] ¥ 7 Z 3R L £,

[Enable Cluster flow-mobility triggered by LISP EID messages] &= v 7 AR v 7 A% A 12 L

7,

[Finish) 227V 27 LT, #—ERARY > — L—LEZHELET,

[#mK (Configuration) ]>[T/3f A& (DeviceManagement) |>[EaAKERT—SEY
T 4 (High Availability and Scalability) ]>[ASAY 5 R4 (ASA Cluster) | >[4 5 R 2 HE

(Cluster Members) DIEISEIR L, [ZTFAZ V7 7a—FEE YT 4 ZH%T 5 (Enable
Clustering flow mobility) | F = v 7R v 7 A& AN LET,
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B 5z —roum

ATy 75 [EH (Apply) 1227V v 7 LET,

DSRZ/—FDEE

VSRR EBALT BT, 274X al—a B LB L, VIR ) — REEMTEFE
ﬁ‘o

HlE/ — D LDFHLLNT—5 / — FDEN

HfH ) — Kb 7 T AZIZT —# /) — RZBITX £7, High Availability and Scalability ™7 «
P—REFH LT —% /—F&BNT52 b TExET, Hlfll ) — Ko7 —% /7 — &8
M35e, 77AZHEY 7 2RETE, BNTHET —F /) — NI TAZ A X —T =
AAE—REHETEZDHENI AV Y BB £T,

Fold, 7%/ —KieusA L, J—RETEEI FAX ) TERETDHIEHTEE
T 72720, VTARAZY T A X—T M LI2tkIE, ASDMtE > v a UBEI S b DT,
T 2 0ERH Y £,

1R BHHEIIZ

s WNNF AT FARE-RTH, VAT ARITAN—ATROFIRZETLES, £72v
AT HhaAT 4 FXalb—arET—RICA>TORWES, [k (Configuration) ]>[7
SNA AY A~ (DeviceList) ]XA T, 77T 4 TIRT AL ADIPT RLAD FIZHD
[V AT L (System) | ZXTN7 Y w7 LET,

WXy NT—2 LTI —FRA Ny T ar 74 Xal— g VERETLIRAIE. T—
X ) —RIZT VB AAHRERIP 7 RL ARG D Z AR LT IE &,

FIE

RATv 1 [#EK (Configuration) ]>[7/34/4 REHE (DeviceManagement) |>[Ea A ERTr—5E Y
F 4 (High Availability and Scalability) ]>[ASAY 5 R4 (ASA Cluster) |>[7 5 R5 A >
/83— (Cluster Members) | DJEIZER L F 9,

ATwT2 B (Add) 1227V v 7 LET,

ATV T3 RONRTA—FEFZELET,
e [A =% (MemberName) |: 2DV 7 AKX X L /3—DEH DARIZ 1~ 38 3LF-D ASCII
LFHITHRELET,

o [A U N—DENARL (Member Priority) | : #lffl / — F®EMHIZ, 2D/ — NOELIAAL
Z 1~ 100 OFPFHANTHE L E T, 1 Biem OEISEIEN TF,
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| AsAv 524
k707497 —rizs |}

o[ T AXHEY > 7 (Cluster Control Link) ]>[IP7 KL A (IP Address) ] : filffl / — Ko
7 ALY 7 LRIy hT—2 BT, 2T ALY 7 DDA NI
DIPT RLAZEELET,

s [BBAA 72 2 > (Deployment Options) | fEI&k T, KD [Deploy Byl A7 > 3 > DWW Fium
ZIBIRL E7,

[T <UE— b=y MICLIZ~Y R& {575 (Sending CLI commands to the remote
unitnow) ]: 7 — hA KT v TBIEET =X/ —F (k) HEHIPT FLAZEEL
T, F—F - FEBIPT LA, 2—F—4%, SAT—FRE2AHLET,

s EESNTZCLIZ~ Y REFHTat— LT, VE— =y MY {HT 25 (Copying
generated CLI commands to paste on the remote unit manually) ]: 7 —4 /— K@ CLI T
A REHN Yy b7V RN—=AFT&SH, £7IZASDM O CLI Y — VA2 TE %
Eolca~wr FEARLET, BT 52~ K (Commands to Deploy) ] v 7 A
T, B AT A~y REBIRLCar—LET,

Deployment Options
Deploy By: | Copying generated CLI commands to paste on the remote unit manually =

Commands to Deploy:

cluster interface-mode spanned force
clear configure cluster
interface GigabitEthernet0/4
no shutdown
cluster group clusterl
local-unit asalo
priority 2
cluster-interface GigabitEthernet0/4 ip 192.168.5.2 255.255.255.0
key test
enable as-slave noconfirm

ATy T4 [OK]ZZ7 VU7 L, SHICHEA (Apply) 1227V w7 LET,

7V T14T/—FIZHB

I ITARDIET T 4TI AN DIZNE, V7 TAR Y T ary7 4 Falb—a 3E
FEPNZ, FO/)—FETrI2AZY T 2T 42— NI LET,
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B o —rroor—s/—rok7o74 Ttk

\}

GE)

ATy T

ATy T2

ATvT3

ASA (FENT, FREINA T2y 7 27 —I1280) ET 7T 472D E, TRTOT—
BAVE—=T A ANV Yy NETENET, BHEHA VXA —T 2 A ADHBN T T 4 v
VEEZETEEST, NI 740y 77 —2BHIELIZE. 2 7AF ) TEHBRA RX—T
MILET, FF. 2O/ —RE7 FAINLERICHIRLES, BHA X —T x4 A
X, FD/—RB7 FZAZIP T—IinbZ -7 IP 7 KLU A% L Chl &kt = B EikRE
L Ed, FEL, V=KL THL/ —RKBRI TAXNTEET 7T 4 7 TlERWgGEE (7
TABY TP IRE CRELRGT LI ARE) | BHA V2 —7 = A AT
T, ERLBEOa Yy 7 4 Xab—va UEEICE, ary Y — A R— N EERTILNERH
£7

1R BHHIIZ

s VNTF AT HRRAL T ROBEIE, ZOFIEE VAT AFETAR—ATETLET,
FIEVAT A AT 4FXFal—vay = RICA> TWARWEGAIL, [Configuration] >
[Device List] ™A > C, 77T 4 77T 3A4 ADIP T KL AD F|ZH D [System] & X 7 /L
70y 7 LET,

FIE

[#mX (Configuration) ]>[T/%f A& (DeviceManagement) | > [Er A% ERT—SE Y
T« (High Availability and Scalability) ]>[ASAY 5 X4 (ASA Cluster) 1> [V T X2 HRE
(Cluster Members) | DIEIZEN L F 9,

[Participate in ASA cluster] = v 7 Ry 7 A%+ 72 LET,

(G¥)  [Configure ASA cluster settings] T = v 7 AR v 7 A% A 7IZL72WTL T3V, 71
THE, TRTDOIFTAZ a7 4Xalb—arin7 )78, ASDM Mk &
IWCWDLEHA =T 2 A A FLTXTOA L F—T oA ATy hF UL
FI, ZOHRA, BEREAETTHICE, 2 Y=V AR— N TCLIZT 72T 54
ERHY ET,

[Applyl 27 U v 27 LET,

HEH/ — DT —2/—FDETI T4 71k

T8 )= R&HT T 4 7T DHITIE ROFIEZFEITLET,
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s5z28~0Esm ||

\}

GE)  ASAMIET /T 4 Thed b, T RXTCOT—HF A F—T = A ANV Yy MU ENET,
BHERA A —T 2 A ADBHBNINT T 4 v P EEZETEEST, N T T4 v T T —%
THITE, 7 T7ARZ VT EREANILET, BHA X —T A XL, EO ) — KB 7 7
AL T —=NANOZITWATIP 7 RV AR L ol S BMpRE s £7, 72720,
Je—RLTH/ =B TAXNTERLET VT 4 7T TIRHRWEES (7T AX ) TR
REETHELMRGFELTSEARYE) | BHA LV H—T oA ZTEHRY £, ZHLUBED =2
TA4FXab—vaMEEEL, Y=V R— b EEATLIVNERH D T,

1R BRI

~NF ArTEARNE-FOLEIT ZOFIEE AT LFTASN—ATEITLES, £
VAT A AT 4 X2 lb— g E— RIZ ATV WEEAIE, [Configuration]>[Device List]
RAVT, TITATIRTFNRALADIPT FLADTFIZH D [System] Z X 77V v 7 LET,

FIE

AT w71 [#R (Configuration) 1>[7 /34 X EE (Device Management) | > [ERIAMERT—FEY
T 4 (High Availability and Scalability) ]>[ASAY 5 X2 (ASACluster) | DJHIZEIR L 7,

ATv T2 HIRETA5—4 ) — REBIRL T [HIEE (Delete) 1227V v27 LET,
F—H)—ROT— A TGy Far 74 F¥al—aZRLTHY ., FOREEFERI L
R UBT—Z ) — FEeHBINTE 7,

ATy 73 [EH (Apply) 1227V v 7 LET,

DS RAIANDOBESM

= RN T A2 IBHEIBRESNTZGG (2l 21X BENRELIA V=T =4 ZDRE,
ELFAARN=ZFITHT 7T 4 7 LIEEE) 1 7 7 AZICFHTHSNT DLENH
0 ET,

1R BHHEIIZ

c JTARABN U T A RI—TNCTHITIE, ary =V AR— AT OLERHY F
T, MOA A =T 2 A ATy AT ENET, 7272, ASDMTY T AX Y 7
ZFETEMC LGS, REEZMRFEL T r— R Lo 28E581F, ASDMTY 7 A%
Vo7 aFBOEMCTEET, Va— g, BHA X —T = TN D720, =
VIV T IRANRT TARE) T EFOENCT HME—DIETT,

T NF AUTHRAL T— ROEAIE, ZOFIEEZ S AT WFITASL—=ZATETLET,
FLEVAT LA a7 4F2b—Tay ET— RIA>TWRWEATX, [Configuration] >

ASAY S R4
I



B /s5xsroome

ATy I

ATy T2

ATvT3

AsAY 524 |

[Device List] XA > T, 77T 4 T7T /A ADIPT KL AD FIZdH % [System] & X 7 /L
70y LET,

© 7T AZ~OEBNZBITT ORI, BEENFRSN TS Z L2l L ET,

FIE

ASDM IZEET 7B AL TV L5EEIE, A X—7 k35 / — FIZ ASDM Z#5e L .

ASDM TZ ZAZ Y v 7 HFOENCT D2 LN TEET,

LA N=E LTEMLTWRWRY  7F—% )= R0y 22 Y 7 %4l ) — Rind

BOEMNITHZLITTEERA,

a) [#R (Configuration) ]1>[T/%f AE¥# (DeviceManagement) |>[ErIAERT—5
E1)F 4 (High Availability and Scalability) ]>[ASA% 5 X4 (ASA Cluster) ] OJIEICE
RLET,

b) [Participate in ASA cluster] 7= v 7 R 7 A% 42 LET,

¢) [Applyl &7 U w7 LET,

ASDM Z i C&72WGE - av Y — /LT, JI7AKX a7 4FXal—ar E— K&Bth
LET,

cluster group name

51

ciscoasa(config) # cluster group podl

TIGAEN T A X—T N LET,
enable

552505 DRHE

I T AEPOEREEIIMIRET AL, VTAX T— b ATy T ar 74Xz lb— g 2K
ZHIRTAMLENH D T, &/ —FOBEOa L 74 Xalb—Yalit (TIV/T 4722y
FBRMENT) FILTHDLED, JTAXZMPBMIBETHE, VTAX Y U TRiOa T 4
X2l —alamwR_y I T v NOEITTHN, IPT RLVAOBGERIT D07 X
L=y a VY EHEHELTHIDNERVET Z &b EIZR Y 7,

1R BRI

ay V=LA — b eFEHTEILERHVET, 7T7AXOaL T 4 Falb—a EHIRT S
LB HE—T A RE T TREHY) I BETRTOA L E—T A AN v v b
H o EnET,
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ATy

ATy T2

ATvT3

ATvT4

ATy TH

ATvT6

v5zams0mE [l

FIE

HHEY )= ROGE, VTAZY T EROEIICT 4 =T M LET,
cluster group cluster_name no enable

51 :

ciscoasa(config)# cluster group clusterl
ciscoasa (cfg-cluster)# no enable

TIAR) TN T—H ) — R ETA F—T N> TWAEIE, 274 F¥a21b—va B
BEAEITHZEIETEERA,

JIGAR AT 4 Xal—alrE U T LET,

clear configure cluster

ASAIX, BHA L X —T oA AL T TABZGIHY) 7 2 FHT XRTOA L H—T 2 AT ¥
rNE T LET,

PSGAR AR —T oA A E—RETFT =TT LET,

no cluster interface-mode
EF—RNFar74¥ab—raZIRfFSninied, FEITY By N A0ERSHY F
@—O

Ny 7T o Far7 s Xal—rarPDbdhEs, EfTar74Fab—Tal iy s 7Ty
T arJ 4 ¥al—arkar—_LFE T,

copy backup_cfg running-config

51

ciscoasa(config)# copy backup cluster.cfg running-config
Source filename [backup cluster.cfg]?

Destination filename [running-config]?
ciscoasa (config) #

a7 4 K2l —varEAL— T S IREFELET,
write memory

S

Ny T a7 4 FXalb—a N 0WEEE. BT 78 2A2HBRELET, &%
WE, A H—Tx2A AIPT FLARZEFL, ELWKA MMEETLET,

ASAY S R4 .
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HlfE/ — FDER

A

FE

cll

ATy T
ATy T2

ATvT3
ATy T4

H — FEZE S 2R BEOTEZ, il —FTr 722V o728\ L, 8 LOilE =~
=y FOBREFFS T D, 77 AZ Y 7 2BEANIT H5ETYT, Hil#l/ —FZTs
J— REREICIRET DMLENS HH0IE. ZOHEOFNEELHER LY, =720, PRpEpi
DL AL, ZOFIEAMEM L THIE , — RER 258925 & T~ TOHERS Fr v 7S
DT, FLWHIE Y, — N LT 2 BT DL ERH Y 7,

HilfE ) — F 2 2B 5123, ROFIEZFITLET,

15D BN

SNANTF AT IR T FOHBEIE, ZOFMEEL AT AFETAR—ATEITLET, £
VAT A AT 4 X2 b— g E— RIZAS TV WEAIE, [Configuration]>[Device List]
NRAVT, TIT A4 TIRTNAADIPT RLAD FIZH 5 [System] X T2V w7 LET,

FIE

[Monitoring] > [ASA Cluster] > [Cluster Summary] % &R L £ 7,

Ry 7HZY )R NPl — T 57— 7 — REBRL, Hlil ) — N3 o8%
7 Vw7 LET,

filf ) — FOEEEZMRT DL OICROLNET, [Yes] 227V v 7 LET,

ASDM #f&T L, A 7T AZIPT RURAZMMH L TR L E7,

PDIREZEERTOIARY FOET

aAvy R&E7 FAZRNOTRTO /) — N2, EFRFFHFED ) — REETLITE. RKOFIEE
FITLET, show 2~v > RETXTO/ — RIZEEFETDH L. TXTOHABIUE S CHE
D) —RKOaryy—IErEINET, TOMmMoa~r R, 72L& 21F capture<° copy . 7
TAZEERTOIATEIEN TEET,

48D HHEIIZ

AV RIA A E—T 2 A XY —/)LTCZOFNEEFLTLET, [Tools] > [Command Line
Interface] Z BN L £ 7,

FIE

TRTO/—RZasvry Fe#MELET, /—FMAEZRELLAIE. FED/ — RIkEL
=7,
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ASAYSREME=L—Y Y .

cluster exec [unit node_name] =~ > K

51

ciscoasa# cluster exec show xlate

J— R4 &2FRT HI21E, custer execunit ? (RIED /) — RERLS T RTOLARINERIN
%) L AST 5D, showcluster info =2~ RE AN LET,

il

FLXY ST 77 ANET TAZNOTNTOD /) — RS FEIEEZ TFTP H— N2 =
E—3 22X, il — FCkoa<r FEANLET,

ciscoasa# cluster exec copy /pcap capture: tftp://10.1.1.56/capturel.pcap

D PCAP 7 7 AV (% — Rinb 15F2) BTFTP F—NZav—ashET,
BHDFX ¥ T F ¥ 7 7 A NAITIZEEIC ) — RARIIS 4L, capturel _asal.peap,
capturel_asa2.pcap 72 &L 720 £9, ZOHITIX, asal & asa2 [TV T AFZ /) — R4 T
ED

W OHTIiL, cluster exec show port-channel summary =~ KOHENIZ, 7T AX D
4/ — R ® EtherChannel {3 F R N TVWET,

ciscoasa# cluster exec show port-channel summary

maSter(LOCAL):***********************************************************
Number of channel-groups in use: 2

Group Port-channel Protocol Span-cluster Ports

—————— o
1 Pol LACP Yes Gi0/0(P)

2 Po2 LACP Yes Gi0/1(P)
Slave:******************************************************************
Number of channel-groups in use: 2

Group Port-channel Protocol Span-cluster Ports

—————— o
1 Pol LACP Yes Gi0/0(P)

2 Po2 LACP Yes Gi0/1(P)

ASA Y SAAMDE=RZ—1) Y

7 TAZORE LR AT —BLO NI TN 2a—T 4 T TEET,

DSAB RATF—RADE=ZHZ—Y) Y

75 A2 DIRIEDTE=2—1 L TI2HoWNWTIE, ROEHEZSZB L TLF I,

ASAY S R4 .
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* [Monitoring] > [ASA Cluster] > [Cluster Summary]
ZDONRA T, HEHFD ) — RE 7 FAZDEDMD ) — ROERPERSNET,
Flo, ZOXL U TTIA<Y) ) —REEETHI LM TEET,

¢ [Cluster Dashboard]

T4~ ) — RDKR—L—ID[F T AXH v 2R — K (Cluster Dashboard) & [Z
FABET 7 AT A —NH v 2R — R (Cluster Firewall Dashboard) | ZfEH L TZ T X
AEE=HTEET,

DS REIEERDINT Y DX TF ¥

U TGAETONRYT y hDOF ¥ TF X IZHONTIE, ROBEHEESBL T ZEW,
[Wizards] > [Packet Capture Wizard]

JIGARBIRD NT TNy a—TF 4 T Y R— 5121, #l ) — R ETos I 2AZEE
N 749 7D0F YT FYE2AMMILET, ZNT, ZTAXNOTRTOT—X /) —FThH
HEWICH e D 7,

DSRZ)Y—RADE=ZZIJY
JTGABY ) —=ADE=HL Y OV TIE, ROBEEHEZSRBL T EE0,
* [Monitoring] > [ASA Cluster] > [System Resources Graphs] > [CPU]

ZONRAL T, VTAX ) —REERO CPUERARE ™V T 7 E 70137 — 7 NV EVER
THZENTEET,

* [Monitoring] > [ASA Cluster] > [System Resources Graphs] > [Memory], Z D<A > TliL, 7
FAK ) — RERD [Z22&% AV (Free Memory) ] & [l A€ U (Used Memory) |
BRRTDHTTTELNET T NEERTHZENTEET,

D3RR T4 99DE=ZR) VT
JIGARNGT T 4 IDE=FY L TITHONTIE. ROBEHEZZBL T E I,

s [E=% V> (Monitoring) 1>[ASAY 7 A% (ASACluster) |>[ NTF7 74 v I T T7
(Traffic Graphs) ]> [#%#%¢ (Connections) ],

ZDORALUTIER, IV TAZAUNR—2RKOER e " 77 7 E£703T7 — 7 NV EERT 5 2
EMNRTEET,

«[E=%1U > (Monitoring) ]>[ASAZ 5 2% (ASACluster) |>[FF 7 4 w2 757
(Traffic Graphs) ]>[A/L—7"> & (Throughput) ],

ZONRLUTIE, VIARAFAUNR—=BIRD N T T 4 I DAIN—T > N d 7T 7%
T =7 NVEERT D ENTEET,
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s5z88myvonr=2—25 |}

[E=42 1 >%Y (Monitoring) |>[ASAY 5 X4 (ASACluster) |>[V S A2 EBRDE=4
1) >4 (Cluster Load-Monitoring) ]

ZITIE, [v— FE=ZDIE#H (Load Monitor-Information) ]-3A > & [B— KE=X DFf
#f (Load-Monitor Details) | XA NZOW T L ¥4, B—FEZ 2 DERIIE, K%
DAL BZ—=NVDY FGAZAN=D T T 4y 7 A%, BLOREINIHROEFHEL
DY) (F7 40 FTHE30) BDERARSINET, FEBOFHEELRRT HITIF, [m—
KFE=% DOFf#ll (Load-Monitor Details) ] -X4 > &ZfHL £,

DSRAHE) o ODE=ZF—1) 2T
5 AZDREDE=2—Y 2O TIE, ROBEEHESBB LT FEW,

[Monitoring] > [Properties] > [System Resources Graphs] > [Cluster Control Link],

ZDORA LTI, 77 AZEIEY 7 O [Receival] 3 K O [Transmittal] & B4 R 4 £ 45
TI77FENIT =T NEERT D ENTEET,

DIRADIV—T A VIDE=Z—1) 2T
I TAEDN—T 4 2 ZIZONTIE, ROBEHZ SR L T30,
* [Monitoring] > [Routing] > [L1SP-EID Table]
EIDs &4 M ID #/”"3 ASAEID 7—7 VaRRLET,

— » N » E I_l_I
DIRZN)7OAFUTDETE
JTARY T OaX T OFEEICOWNTIL, ROBEHZZRL TS0,
[Configuration] > [Device Management] > [L ogging] > [Syslog Setup]

7 T ABNDE ) — R, syslog A vE—V%HBNCAK LET, [H—FRITRRDT A A
ID f}& Tsyslog A vE—VHART DI ENTE, 7 ITAXNDR—FITRRD 7 — K
LDAvyE—VDEIICRERZENTEET,

ASA VS X5 1) T DB

LIFORFNCIE, — iR EATO ASA DY FAZEEOTRTHOar 7 Xzl —3 3 )
HEENFET,

AMSABLURAYFODAT4FxaL— 32000

RDALT 4 X2 b—a Pl ASAEAL Yy FRIODROA o —T7 = A A& L £7,
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ASAA B —Tx4A4R

RAYFAA—T AR

A—Hx> 12

GigabitEthernet 1/0/15

A —HFxv M1/3

GigabitEthernet 1/0/16

A=Y b 1/4

GigabitEthernet 1/0/17

A —HF v 1/5

GigabitEthernet 1/0/18

BAZY DAV BE—T AR E—FK

cluster interface-mode spanned force

ASA1 &l =y FDT— R S5y TEHE

interface Ethernetl/6
channel-group 1 mode
no shutdown

|

interface Ethernetl/7
channel-group 1 mode

no shutdown
|

on

on

interface Port-channell

description Clustering Interface

cluster group Moya
local-unit A

cluster-interface Port-channell ip 10.0.0.1 255.255.255.0

priority 10
key emphyriO
enable noconfirm

ASA2 T—HR 1=y rDT—FR SV THE

interface Ethernetl/6
channel-group 1 mode
no shutdown

|

interface Ethernetl/7
channel-group 1 mode

no shutdown
|

on

on

interface Port-channell

description Clustering Interface

cluster group Moya
local-unit B

cluster-interface Port-channell ip 10.0.0.2 255.255.255.0

priority 11

. ASAY S R4
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key emphyriO
enable as-slave

HE1L=w FDA B —T 24 AKRTE

ip local pool mgmt-pool 10.53.195.231-10.53.195.232

interface Ethernetl/2
channel-group 10 mode active
no shutdown
|
interface Ethernetl/3
channel-group 10 mode active
no shutdown
|
interface Ethernetl/4
channel-group 11 mode active
no shutdown
|
interface Ethernetl/5
channel-group 11 mode active
no shutdown
|
interface Managementl/1
management-only
nameif management
ip address 10.53.195.230 cluster-pool mgmt-pool
security-level 100
no shutdown
|
interface Port-channellO
port-channel span-cluster
mac-address aaaa.bbbb.cccc
nameif inside
security-level 100
ip address 209.165.200.225 255.255.255.224
|
interface Port-channelll
port-channel span-cluster
mac-address aaaa.dddd.cccc
nameif outside
security-level O
ip address 209.165.201.1 255.255.255.224

Ciscol0OS XA/ vy FDaAV T4 FalL—ay

interface GigabitEthernetl/0/15
switchport access vlan 201
switchport mode access
spanning-tree portfast
channel-group 10 mode active

|

interface GigabitEthernetl/0/16
switchport access vlan 201
switchport mode access
spanning-tree portfast
channel-group 10 mode active

|

interface GigabitEthernetl/0/17

ASAY S R4
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B =<7 vrtoo74791—n

switchport access vlan 401
switchport mode access
spanning-tree portfast
channel-group 11 mode active
|
interface GigabitEthernetl/0/18
switchport access vlan 401
switchport mode access
spanning-tree portfast
channel-group 11 mode active

interface Port-channellO
switchport access vlan 201
switchport mode access

interface Port-channelll

switchport access vlan 401
switchport mode access

ATAVILEDT7AT7o4+—IL

Node 1
management
10.1.1.1/24 (Pool: .2-.9),
: 2001:DB8::1002/64
- _ .| (Pool: 8 IPs)
2 E 2l =| E
= o = = o
© E of © E
Cluster Control Link
192.168.1.1, .2, and .3
< port-ch1 Spanned >

port-ch1.10 inside VLAN 10 10.10.10.5/24, 2001:DB8:2::5/64
| MAC: 000C.F142.4CDE |
port-ch1.20 outside VLAN 20 209.165.201.5/27, 2001:DB8:2::5/64
MAC: 000C.F142.5CDE

|

—

N

R

|

port-ch5
VLAN 10, VLAN 20 Trunk

Switch

lVLAN 10 |

J

I

Client
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BB Xa2 VT 4 RALUDODT—X NT77 4 v 712i%, #7225 VLAN BBEA T S
£9, 72& 2 IENE R Y b U — 27 I VLAN 10, MR~ hU—2Z7 121X VLAN20 & L E

T, K ASA FH—DOWER— BBV, AL v T ERFN—FIZERINET, T
XUTNA R =T M5 TWEDT, YELY 7 EOFTRTO/NT v F3802.1q 7 711k
ENET, ASA L., VLAN10 & VLAN20 DD 7 7 A 77 5 —/LT1,

A% R EtherChannel Z 325 & &%, XA v TFMTTRTCOT—Z VoI RNTA—FE
#LC1>® EtherChannel & 720 3, ASANFEHRARRIZR > T2HA13. A1 v FIIEYV o=
=y MEATrZ 74 v 7 /oM LET,

LBAZY DA VB —T AR E—FK

cluster interface-mode spanned force

A=y MEIEHIZY FODT—FR S5y TEE

interface ethernetl/8
no shutdown
description CCL

cluster group clusterl

local-unit asal

cluster-interface ethernetl/8 ip 192.168.1.1 255.255.255.0
priority 1

key chuntheunavoidable

enable noconfirm

AZY b2TF—22=Zy FDT—FR S Y TERE

interface ethernetl/8
no shutdown
description CCL

cluster group clusterl

local-unit asa2

cluster-interface ethernetl/8 ip 192.168.1.2 255.255.255.0
priority 2

key chuntheunavoidable

enable as-slave

A=y r3T—5221=Y bDT— RSV TRE

interface ethernetl/8
no shutdown
description CCL

cluster group clusterl

local-unit asa3

cluster-interface ethernetl/8 ip 192.168.1.3 255.255.255.0
priority 3

key chuntheunavoidable

ASAY S R4
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enable as-slave

HE1L=w FDA B —T A4 AKRTE

ip local pool mgmt 10.1.1.2-10.1.1.9
ipv6 local pool mgmtipvé 2001:DB8::1002/64 8

interface management 1/1

nameif management

ip address 10.1.1.1 255.255.255.0 cluster-pool mgmt
ipvé address 2001:DB8::1001/32 cluster-pool mgmtipvé
security-level 100

management-only

no shutdown

interface ethernetl/1
channel-group 1 mode active
no shutdown

interface port-channel 1
port-channel span-cluster

interface port-channel 1.10

vlan 10

nameif inside

ip address 10.10.10.5 255.255.255.0
ipv6 address 2001:DB8:1::5/64
mac-address 000C.F142.4CDE

interface port-channel 1.20

vlan 20

nameif outside

ip address 209.165.201.1 255.255.255.224
ipv6 address 2001:DB8:2::8/64
mac-address 000C.F142.5CDE

. ASAY S R4



| AsAs 524

NS T4 v D

L N |

Cluster Control Link
port-ch1
192.168.1.1, .2, and .3
Node 1
3N /\ _eth1/6
3[} [ ethirz A
A =N A eth1/8 (Y ethoi1 -
\ &
— w
o mgmt | —
zol Node 2 =5
= -
AL 55 giEN E
o o= ?mf 8& oy
8 AW §53% 5 eth2/1| SBEZ 8
z Ond - | o200 o
E: :Dc}g"o E:C’%qg i
528 mgmt S
- 58 2 op &
A OZ_ "B/ elhl/f =14
ol | a | [3l ] etz &
@/ X | [ 2V ethiss >
V V V V
mgmt
management
10.1.1.1 (Pool: .2-.9)
2001:DB8::1002/64 (Pool: 8 IPs)

WEF Y U =27 LR Y FU =2 DRIT, 877 4 v 7 2RI TEECE £

FoRicRT L 9c, ENc—F DA 3 REtherChannel 3% 0 . WNESA A v F IS T
WET, MHITERICH Y, AL v TFITER SN TWET, KETHIUL, £ EtherChannel
FIZVLAN B 7 A v Z—T oA Z%2{ETHZ b TxET,

BE1=Y DA VE—T AR E—F

cluster interface-mode spanned force

A=y MEIEHLI=ZY FOT—FR S Y THRE

interface ethernet 1/6
channel-group 1 mode on
no shutdown

interface ethernet 1/7
channel-group 1 mode on
no shutdown

interface port-channel 1
description CCL

ASAY S R4 .
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cluster group clusterl

local-unit asal

cluster-interface port-channell ip 192.168.1.1 255.255.255.0
priority 1

key chuntheunavoidable

enable noconfirm

AZw br2TF—422A=y bDT—FR S Y THE

interface ethernet 1/6
channel-group 1 mode on
no shutdown

interface ethernet 1/7
channel-group 1 mode on
no shutdown

interface port-channel 1
description CCL

cluster group clusterl

local-unit asa2

cluster-interface port-channell ip 192.168.1.2 255.255.255.0
priority 2

key chuntheunavoidable

enable as-slave

A=y R3IT—RA=Y FDT— R SV TEHRE

interface ethernet 1/6
channel-group 1 mode on
no shutdown

interface ethernet 1/7
channel-group 1 mode on
no shutdown

interface port-channel 1
description CCL

cluster group clusterl

local-unit asa3

cluster-interface port-channell ip 192.168.1.3 255.255.255.0
priority 3

key chuntheunavoidable

enable as-slave

HE1I=Z FDA B —T A AEKTE

ip local pool mgmt 10.1.1.2-10.1.1.9
ipv6 local pool mgmtipvé 2001:DB8::1002/64 8

interface management 1/1

nameif management

ip address 10.1.1.1 255.255.255.0 cluster-pool mgmt
ipv6 address 2001:DB8::1001/32 cluster-pool mgmtipvé

. ASAY S R4
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/%> K EtherChannel £/3y 57 v 7 U2y (k08771 I8 Ravri4) [

security-level 100
management-only
no shutdown

interface ethernet 1/8
channel-group 2 mode active
no shutdown

interface port-channel 2
port-channel span-cluster

nameif inside

ip address 10.10.10.5 255.255.255.0
ipv6 address 2001:DB8:1::5/64
mac-address 000C.F142.4CDE

interface ethernet 2/1
channel-group 3 mode active
no shutdown

interface port-channel 3

port-channel span-cluster

nameif outside

ip address 209.165.201.1 255.255.255.224
ipv6 address 2001:DB8:2::8/64
mac-address 000C.F142.5CDE

A /N> K EtherChannel £ /Ny o7y T )2y (RKED8TFTHU T4 7/8

AR INA)

1€ D BtherChannel D7 7 7 4 7 AR— MO KREIT, A4 v FNHHD 8 IZHIREET, 8
=y MIBRND T T AXNHY . EtherChannel (2= F&H7=0 2 R— F&H 0 B TGS
I A6 A= DI HAR—FERAZ VAN F— NITLOIRLENRDHY 7, ASAIL, £ED
Vo %777 4T EFAZ AT B0%E, LACPEMH L CxrIvz— R LET, VSS
F 7213 vPC i L T~ /L F A A v F EtherChannel A 1 — 7 /W LI=HAEIL, A A v FHEO
TLEMZEHRTEET, ASATIHE, TXTOYEAR— FREINICAR v MEFIA, RIZA—
BRI~ HNET, ROKTIE, B5O/NZWAR— I THIE] A—FeR0 (& 23
Ethernet1/1) | 573 17 —% ) R— &7 0 3 (J2& 21X Bthernet1/2) . /N— RU = 7#%
FEORIFMEZ RFET D MERHV FT, 2FED, TXTOHIHY 71T 1 EDAA v F &
LR FTRTCOT =V T IEFBIOARAL v FREEGGE 72> TV DHENRSH Y £9° (VSSVPC
DEHINTWAEE) . ROMKIX, 7 7 AZIZSMT 5=y "X TY 7 OREH Y
MU7zE &L, EOXIITRDNERLTVET,
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B =< EEtherchamnel /Xy ST YT UL Y HEERDETH T TBRE L)

Router or Router or Router or
Access Switch Access Switch Access Switch

Switch 1 Switch 2  Switch 1 Switch 2

b Py

Virtual Switch Link Virtual Switch Link

1. Up to 4 nodes

Node 5
2. 5th node joined

Node 8
3. Maximum of 8 nodes

JFRIE LT, MIDICTF ¥ RANDOT 77 4 THR— MiERRKILL, 2D 2T, 777477
FIHAR—NET 2T 4 TRT—HR— b OEONRT A ELET, SEHO2Z=y N7 T
AZCBMULTIEEEIE, VT 74 v 7 BT RTO2=y MIEFITEINMEN RN D LITHER
LTLZENY,

Vo7 E3T A AOBEREAE L&, RUFATOUIESNET, TO/RE, v—F
RGN RBBIZIIR W2tV FET, ROMIE, 4=y DT T RE
ZRLTWET, Z0Oa=y rD1DT, BV JEENEELTWET,
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R8> F EtherChannel &8y 5 7 v T Uy (k0875571 I825 1) [

Router or
Access Switch

Switch 1 Switch 2

Virtual Switch Link

=3
=2

v b U —27 NIZHE%L D EtherChannel 2 5% ET 25 Z £ b &2 b E T, IO TIL, EtherChannel
DNEBIZ 1D, FMBIZ 128D £7°, ASAIL. —F @ EtherChannel THlfHl & 7 — % Ol 5 D Y
VI REERIEIZ 2 S TG AT T AZNOHIBRSILE T, ZiUX, D ASA BT TIZHER
F v T =7 ~OERiE RS> TWDBIZEPDb LT, MRy NI—I b NT 7 4 v T %
BT20%<T2HTT,
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. Z /8> K EtherChannel &£/8y 07 v T Yl (EED8THU T4 TBAREINA)

Router or
Access Switch

N\

Inside

Router or
Access Switch

LAY DA VB —T AR E—FK

cluster interface-mode spanned force
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Z /8> K EtherChannel &/8y 2 F7 v T Y2y (EEKD8T U T4 TBREINA) .

A=y MEIEHIZY fDT— R S5y TEE

interface ethernet 1/6
channel-group 1 mode on
no shutdown

interface ethernet 1/7
channel-group 1 mode on
no shutdown

interface ethernet 1/8
channel-group 1 mode on
no shutdown

interface ethernet 2/1
channel-group 1 mode on
no shutdown

interface port-channel 1
description CCL

cluster group clusterl
local-unit asal

cluster-interface port-channell ip 192.168.1.1 255.255.255.0

priority 1
key chuntheunavoidable
enable noconfirm

AZY b2TF—22=Zy FDT—FR S Y THRE

interface ethernet 1/6
channel-group 1 mode on
no shutdown

interface ethernet 1/7
channel-group 1 mode on
no shutdown

interface ethernet 1/8
channel-group 1 mode on
no shutdown

interface ethernet 2/1
channel-group 1 mode on
no shutdown

interface port-channel 1
description CCL

cluster group clusterl
local-unit asa2

cluster-interface port-channell ip 192.168.1.2 255.255.255.0

priority 2
key chuntheunavoidable
enable as-slave

ASAY S R4 .
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A=y R3F—EA=Y rDT— R RSy T

kg
it

interface ethernet 1/6
channel-group 1 mode on
no shutdown

interface ethernet 1/7
channel-group 1 mode on
no shutdown

interface ethernet 1/8
channel-group 1 mode on
no shutdown

interface ethernet 2/1
channel-group 1 mode on
no shutdown

interface port-channel 1
description CCL

cluster group clusterl

local-unit asa3

cluster-interface port-channell ip 192.168.1.3 255.255.255.0
priority 3

key chuntheunavoidable

enable as-slave

A=Yy MAT—R2AZY bDT— PR SV THE

interface ethernet 1/6
channel-group 1 mode on
no shutdown

interface ethernet 1/7
channel-group 1 mode on
no shutdown

interface ethernet 1/8
channel-group 1 mode on
no shutdown

interface ethernet 2/1
channel-group 1 mode on
no shutdown

interface port-channel 1
description CCL

cluster group clusterl

local-unit asa4

cluster-interface port-channell ip 192.168.1.4 255.255.255.0
priority 4

key chuntheunavoidable

enable as-slave

. ASAY S R4
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L—FyEE—K44 rIsS22Uvs0ovEE [

HEI=y FDA 2V EF—T 14 RAKFE

ip local pool mgmt 10.1.1.2-10.1.1.9

interface management 1/1

nameif management

ip address 10.1.1.1 255.255.255.0 cluster-pool mgmt
security-level 100

management-only

interface ethernet 2/6
channel-group 3 mode active vss-id 1
no shutdown

interface ethernet 2/7
channel-group 3 mode active vss-id 2
no shutdown

interface port-channel 3

port-channel span-cluster vss-load-balance
nameif inside

ip address 10.10.10.5 255.255.255.0
mac-address 000C.F142.4CDE

interface ethernet 2/8
channel-group 4 mode active vss-id 1
no shutdown

interface ethernet 2/9
channel-group 4 mode active vss-id 2
no shutdown

interface port-channel 4

port-channel span-cluster vss-load-balance
nameif outside

ip address 209.165.201.1 255.255.255.224
mac-address 000C.F142.5CDE

W—T Y RKE—FKHYAFEIISRE)2TD0TVERE

AN K EtherChannel Z i L7z —7 v K E— RIZ&$T B9 A4 "NEZ T ALY 7DD

X, OTV OEYIRRE L E=F Y Tk > TR £9, OTVIE, DCI &KIZ N7y M &
Rk 52 & T, BEAKEEZRL-ZLET, OTVIL, kT —7/LICMACT R L R &2
HEXIZOH, DCIERIZZ=F ¥ A b Ty ML LET, MAC T RL A OTV Hidk

T MIFE SN TWRWES, 2=y A~ Xy MIRey7anE7d,

0TV X E D5l

//Sample OTV config:

//3151 - Inside VLAN, 3152 - Outside VLAN, 202 - CCL VLAN
//aaaa.1111.1234 - ASA inside interface global vMAC
//0050.56A8.3D22 - Server MAC

feature ospf
feature otv

mac access-list ALL MACs

ASAY S R4 .
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10 permit any any
mac access-list HSRP_VMAC
10 permit aaaa.1111.1234 0000.0000.0000 any
20 permit aaaa.2222.1234 0000.0000.0000 any
30 permit any aaaa.1111.1234 0000.0000.0000
40 permit any aaaa.2222.1234 0000.0000.0000
vlan access-map Local 10
match mac address HSRP_VMAC
action drop
vlan access-map Local 20
match mac address ALL MACs
action forward
vlan filter Local vlan-list 3151-3152

//To block global MAC with ARP inspection:
arp access-list HSRP VMAC ARP
10 deny aaaa.1111.1234 0000.0000.0000 any
20 deny aaaa.2222.1234 0000.0000.0000 any
30 deny any aaaa.1111.1234 0000.0000.0000
40 deny any aaaa.2222.1234 0000.0000.0000
50 permit ip any mac
ip arp inspection filter HSRP VMAC ARP 3151-3152

no ip igmp snooping optimise-multicast-flood
vlan 1,202,1111,2222,3151-3152

otv site-vlan 2222
mac-list GMAC_DENY seq 10 deny aaaa.aaaa.aaaa ffff.ffff.ffff
mac-list GMAC_DENY seq 20 deny aaaa.bbbb.bbbb ffff.ffff.ffff
mac-list GMAC_DENY seq 30 permit 0000.0000.0000 0000.0000.0000
route-map stop-GMAC permit 10

match mac-list GMAC_DENY

interface Overlayl
otv join-interface Ethernet8/1
otv control-group 239.1.1.1
otv data-group 232.1.1.0/28
otv extend-vlan 202, 3151
otv arp-nd timeout 60
no shutdown

interface Ethernet8/1
description uplink to OTV_cloud
mtu 9198
ip address 10.4.0.18/24
ip igmp version 3
no shutdown

interface Ethernet8/2

interface Ethernet8/3
description back to default vdc e6/39
switchport
switchport mode trunk
switchport trunk allowed vlan 202,2222,3151-3152
mac packet-classify
no shutdown

otv-isis default
vpn Overlayl
redistribute filter route-map stop-GMAC
otv site-identifier 0x2
//0TV flood not required for ARP inspection:

. ASAY S R4
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L—FyEE—K44 rIsS22Uvs0ovEE [

otv flood mac 0050.56A8.3D22 vlan 3151

YA FEEDOEHIZBRELZOIV I ILEADEER

YA "NET L LESEEIE, Ju— XV MACT RLRE2ZRU ET7Ta vy 7 L THE X D
2. 74 V2% OTV MBHIBRT AMLENRH Y £, HERWSODDBIMRENH D £,

BEEEL CWD YA FTOTV AA v F LD ASA 72— )L MAC 7 RLRIZRITHAXT 4 v
7 o N EEBMTALERSHY EI, 20 bIZk-T, KEHAO OTV 34—/ —1
A AV H—=T oA RAZINHEOZY M) ZBIMTEET, —1"E7 T 472 MZASA HO
ARP = MU BT TIZH 256 (ZHIBFOBROSETT) | ARP IFHXEE SRV
T, ZOFERLIIZRD FT, LER-T, OTVITEEET — 7 /LT ASA 7 72— 3L MAC
T R RAZEETHESITIHY FH A, OTVICITHEET —7 LRI 12— LMACT R L &
DR, OTV OFFZEIZOTV A — "N~ A f X —T 2 A A% N L TL=F % A kX
Ty NET Ty T 4 LRNDOT, =%y AL Xy NI — b0 7 e —30 MAC
T RLRIZ Ry 7, BFOBRITUIB S E T,

//OTV filter configs when one of the sites is down

mac-list GMAC A seq 10 permit 0000.0000.0000 0000.0000.0000
route-map a-GMAC permit 10
match mac-list GMAC A

otv-isis default
vpn Overlayl
redistribute filter route-map a-GMAC

no vlan filter Local vlan-list 3151

//For ARP inspection, allow global MAC:
arp access-list HSRP_VMAC ARP Allow
50 permit ip any mac
ip arp inspection filter HSRP VMAC ARP Allow 3151-3152

mac address-table static aaaa.1111.1234 vlan 3151 interface Ethernet8/3
//Static entry required only in the OTV in the functioning Site

oY A FBETXLIEEEE. 74V ZEHEBIMLT, OTV CIDAZ T 4 v Tk
PHIBRTAMLENHD T, Fa—ULMACT FLADA—R_R—L A = NV E 7 UTT5
Wi, BHFD OTV CHXAFIv I MACT RLR F—TN% 7 VT35 LRIEFICEET
KR

MAC7 RLR T—JLDI Y7

YA WMET L, =L MACT RLAADREZT v 7 2 MU OTV IZiBIENn
HIEAIT, D OTV A —R—L A f L H—T =2 AD T 11—,V MAC 7 KL R &8 T
XDHEVCTHMERDHY T, MOV A FREEBLEZL, 260 NI E7 YT T 540
ERHYFET, OTVOEET —TLICINbDTy FYRRNWT & 2HETH-DI1C. MAC
T RUVAT—=T N ELTHELTITEIN,

cluster-N7k6-0TV# show mac address-table
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Legend:

* - primary entry, G - Gateway MAC, (R) - Routed MAC, O - Overlay MAC
age - seconds since last seen,+ - primary entry using vPC Peer-Link,
(T) - True, (F) - False

VLAN MAC Address Type age Secure NTFY Ports/SWID.SSID.LID

————————— e e e et e
G - d867.d900.2e42 static - F F sup-ethl (R)

O 202 885a.92f6.44a5 dynamic - F F Overlayl

* 202 885a.92f6.4b8f dynamic 5 F F Eth8/3

O 3151 0050.5660.9412 dynamic - F F Overlayl

* 3151 aaaa.l1111.1234 dynamic 50 F F Eth8/3

OTVARP X v v aDE=ZY LY

OTVIZ. OTVA L H—T 2 A AR THFEEHLIZIP 7 FLRITHT S 712 % ARP ~D ARP
FyvrahbfERFELET,

cluster-N7k6-0TV# show otv arp-nd-cache
OTV ARP/ND L3->L2 Address Mapping Cache

Overlay Interface Overlayl

VLAN MAC Address Layer-3 Address Age Expires In
3151 0050.5660.9412 10.0.0.2 1wOd 00:00:31
cluster-N7k6-0TV#

YA EY SRR 2T D

ROPITIZ, YR—hSND7 TAZHEANEZRLET,

BAA B2 —T AR IN—T Yy FE—F /=AY X 54 EDHI

WORFITIE, WEL—2 LA — 2 OMICEE SR (/=AY T REN) 2507 —4 &
VHE—DENFIUC2ODASA VT AL ) — KRS LGEERLET, 7T AKX ) — NI,
DCIRREH D7 Z AZHIHY 7 Ic Ko TS TnET, &7 —F B ¥ —DONEHL—4 &
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SYN/ACK /X7 > "B Fa v 7S aeeEtEdn s 57z
D, —EBDTCP ¥ v g U IHEST SR W TATREMED &
nET,

TITA NA—F— 1 7T T A MEENT ATy NOBE, 797 A b eZETD
JTAR ) —RE, 777 A MOREGFILESEEDOIP T LA, BIUUry MDD

Ny VaBEALTT7 I T AY MA—F—%RELET, TO%, TRXTOT7IT T ALK
WY FZAZGIEHY 7 2 L TCT7 T 7 A NI ABEICEEINET, A vy FOa— RN
TUANy A THERHENDSZ T ME, BHIDOT T 7 A MZOAREENTNDHTD

TITRANNEBIRDB I TAL ) —RiZa— KT TENIEERHY £9, o
I T A MZE, BETLAR— P EFEER— MIEENT, Dy T AKX ) —Kizue—FK
NIV TENDIBERNHY £, 777 A AT BRIy hE2F T
TNT B0, FETHEHRIP T FLALER—=FDONY Y 2 |ZESWTT 4 L7 ZERE
TEET, FILWVEROEAIL., 777 A "OFAENEGITAS L L TRERESNE

To TNDBEGFOEROLE., 777 A MNITEEIL, 77 AXEEY 7 =0 LT, &
ESNTZBRTAEEICT X TOT7 I 7 Ay heirk LEd, 20%, BEROFTAEEILT
TOT7T7 T A N FEELET,

P CAR— b 7 R L AL (PAT) 32 &, PAT DX A 7 (per-session % 7213
multi-session) 23, 7 T AKX D ED A U NPH LWL O A —F— TR DR E L ET,

« per-session PAT : A —F—|&, ORI D/ 7y NE2ZET D/ — RTT,

T 74/ N TlL, TCP B X U'DNSUDP k7 7 1 » 7 I X per-session PAT ZfH L £ 7,

» multi-session PAT : A —F—IZFIZHIHH / — K TF, multi-session PAT $2f5e 237 — % / — K

TEANCZAZENDHE. 7T—4% / — RRZ O &G/ — NIZiEE L £,

57 %) hTiL, UDP (DNSUDP %#[&<) BILWICMP k7 7 ¢ v 7 I multi-session PAT
EHERAT D20, T 0 OERITEICHIE, — RicL o THra SN TWhET,

TCP 3 J UV UDP @ per-session PAT 7 7 4/ h 2 ZEHTEHD T, ZhbD7 1 k3L O
1. FOFREITIS UTC per-session F 72 1% multi-session TULFL XL E T, ICMP DAL, T 7 4

JV K @ multi-session PAT "B EH 95 Z L 1ETX £ A, per-session PAT DFEMIZDOUVNTIL,
(77 AT O+ —NVORERITA R 22 L T 7Z30,
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F OO F M OA—F— 720 FTF, B MHRRIO  — RIZEE LIZSEIEL, £
DRy NI T AFXEIEAY 7 2 LA —F—/ — RIZIBEINET, &l 7 r—~
Y AKRBDIIE, WY — RART U I NRBETT, 1D 7 a—Om S NE T —
RIZEIET D L &b, 7a—0n )/ — FRICHEIZOBEIND L 5123570 TT, Hihmo
Ta—nH0 7 — RIZEFE LIEEAIR, o/ — RV A v7 hEhvET,

TCPOY T ILT—42 70—

WORFNE, LW OMSL 2R L ET,

s 0
1. SYN 1. SYN
SYN/AC
Server
y
Inside Outside |
—
A y 4
Client
After step 4, all 2. SYN/ACK
remaining packets
are forwarded
directly to the owner. Forwarder 8
9 J %
Cluster
1. SYNXXT Y "7 74T D BHIEEI, ASAD 1D (a— K NNT v T HECE
S) KERESNNET, 2t —F—¢RnFEd, A—F—F7vue—%ExKL, 4—
F—1§# A = 22— K LT SYN Cookie Z4K L, /37 v h &V — \Znk LEd,
2. SYN-ACK /37 ERH—"MBERE SHL, BO ASA (B— K ANZ vV kIcES
<) ITBMEENET, ZDASAIT 7+ UV —FTT,
3. 7HU—HIXZOEREITA L UIWRWDO T, A —F—IFH%E SYN Cookie 75T =1—
KL, A—F—~Dirk7 o —%{EfR L. SYN-ACK % A4 —F—IT#&k L £,
4., F—F—FT A VI XITIRET v T T —FEEE L, SYN-ACK 27 74 7 > MIfsk L
e
5. TAVIHAITRET v 7T — b et —F—0bZEL, A—F—~DO7u—%Z{EK L.

A—F— L [ERIC TCPIREE WA LE T, T4 L7 XL, 20ROy I T v
F—F—¢ L TCo&EIZFH E£9,
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6. ZHUEE, 7 U—ZIEGESINTAT Y MITRT, A—F—IliBESnET,

7. Xy MRFOMD ) — RIZEE SN E. 0O —RiZT 4 L7 ZiIZunwiabeT
F—F—FREL, 7a— %Eﬁibiﬁ“o

8. Tu—RENT(LLIZEAIL, RET v 7T — ML —F =0T 4 LI XITEEEN
F7,

ICMP 5& U UDP DY > TILT—2 70—

WOBNL, Hr LB O Z R L ET,
1. E3:ICMPEEUVUDPT—% 70—

1. 1st UDP Packet 4. 1st UDP Packet

Server

Outside -l

5. 2nd UDP Packet

Inside

After step 5, all remaining packets
are forwarded directly to the
owner.

uoneso

Y Forwarder )

Cluster

UDP /X7 > bW FA TV bBRIEEN., 1 DDASA (02— KXRF o v FHEICHES
<) IEMEENET,

2. WMDY NEZE LT — Nt #ELBELETIP T RLRAER— DNy v 22D
WCTEBRINET 4L X ) —F%R2 72 ) LET,

3. T LI HIMFOTe—EREET. T L7 X T —EER LT, LD — R

by "NEREELET, 2FEV., TALIZEARZOT7a—DF—F—FER L2 LITRY
F7,

4 A—F—i@FT7a—z{EKL, T4 L7 HITRET v 7T b EFEL T, il
Ty MR LET,
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5 2FEHDOUDP X7y MIH—"—nbREIN. 7+ V—FITREINET,

6. Z7AU—FIIT 4 LI XK LA EZ 7 =) LES, i En 7 — (DNS
mE) OHE, 7 V=237 )T ROy hRREIZT 4 L7 ZITHERFE L,
TAVIZBREONT y MaeA—T —IZEELET,

7. T AV S RPN E 7 T — SRR L E T

8. T U—FFEERT v — AR L TA—F—IFRERE L. Ty FEeA—F—ITiRE L
£

9. A—F—ITry eI TAT L MIEELET,

HFHLWTCPEHZED Y SR I ERTOEDEL

T TARN)—ALFIZIF T AN — AL —R LB — KRS TORRELT, 7
T —SEUIR Y BEUTEAIE, HILWTCP 7 a—2@\EfD ) — Koo ) — Rl &
AV FTDHEICHRETEET, BFEO7o—Iho /) — FiZiZBE SN ETA,

ASA D SRR 2T DERE

HaE

Y

>

IN—
Tav

HEEEHR

F—sazy kLo

9.14(1)

fli#Hlr=y FTIE, 774NV P TRELENT —F 2=y b ERIFICEHES D &

TE D H 7] ] DT E Lz, PARNZ. EFEICRBITOo TWE L,
BB/ S 7= : [Configuration] > [Device M anagement] > [High Availability and
Scalability] > [ASA Cluster] > [Cluster Configuration] > [Enable parallel configuration
replicateg] = v 7 R v 7 A

7T ABSOSIMK|9140) | 7 T A B 2= NI T AZ OSBRI LTZGEC, 7 7 A X ZRE L1286 O

RHIBRD A v E—
N, LITFEmEnE
L7z, show cluster
history

LA vyE—U0, showcluster history =2~ > RIBIMSVE LTz,
BT Sz~ K show cluster history
PR S Uz 72 L

T v R
(DCD) DFFMF &
WISB DGR, B X
W7 F 2% NO DCD
DF Rk,

9.13(1)

7 v Rt (DCD) # AN L7234 1%, show conn detail =~ > K& LT
T LSBT A EREABS CE Ed, 7 v FERZHERT5 &, IET 2
T4 TR AR CX £, showeonn DL, =2 RARA » 3T e—7&hN
THENRENE T, EBHIC, DCDNYZ TAX THR—FEND L5127 E L,

/AR S 2w : e L,
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JITARDNT T 4
JRAMOT = —

9.13(1)

JIGAZRAUNNDNT T 4y VAMEET=F—TEDHLI2DELE, ZHICE
Gt CPU LAV DFEHE, Ny 7y Fay P RENRGENET, ARN
FTE5A, BYOa2=y NPAWMELETE 5T, 2=y b7 I72X Y
7 % FENITHEINCT 50, SMTAA /7:@13‘—}*/\7///7;5,’nﬂ%‘3—57) ZEIRNT
F9, ZOMEEIX, T 74NV TS R—TMIENTWET,

LV E X7

* [Configuration] > [Device M anagement] > [High Availability and Scalability] > [ASA
Cluster] > [Cluster Configuration] > [EnableCluster Load Monitor] = v 7 &R v 7
A

* [Monitoring] > [ASA Cluster] > [Cluster Load-M onitoring]

7 T AL G OEEk

9.13(1)

FT—HFa=y MRz =y N ERIUHREDHAE, REORMEZ ATy L, %
FEEfb LET, ZOMEREIXZ, T 7 ANV P TA XTI ENTWET, ZOMREIZ
Zy FTLICREESN., =y P DT =Xy MOIER S EE A,

(F)  —EOREI~VC NX 7T AZMEEOEELE BERH Y FEA, 0
boavy FRz=y MIFET D56, 7 7 A X G OmmE b F 2
o TNThH, REOCRMIXFICRAELET, 7 7 AXEEO&EELEEE
IEDITIE, BHNEO RV EZHIBRT 20N H Y £7°, showcluster info
unit-join-acceler ation incompatible-config Z i L T, HHMEDI2WERE &
FoRLET,

BB/ S 7= : [Configuration] > [Device Management] > [High Availability and
Scalability] > [ASA Cluster] > [Cluster Configuration] > [Enable config sync acceler ation]
Frxy IRy T A

ASAY S R4 .



B ssavszxrusoms

AsAY 524 |

HaE

iy

IN—
av

HEEEHR

A NTEDITAHZ

Y > 7 H Gratuitous
ARP

9.12(1)

ASA T, Gratuitous ARP (GARP) /X7 v hZEK L TAL v F T AT T A b
T Fx B HWITRFOREIR S L 21 Lz, &4 NOBEEIAMAED Kb &
WA RZE AT, 77—V MAC/AP 7 RLAD GARP b7 7 4 v 7 BWESICAE
BEIET, 7 TAEZDLEFRINTZTA FTEOMACKBEIOIPT RLAE Ty
RS A FEADOMACT RLABIOIP T FLAZFHATLDOICH L, 7T AZT
ZIE LAy ML, 77—V MACT RLABEIOIP 7 FLAZFERALES, b
T4y N7 a—rULMAC 7 RLUADNLEMICER SN WGE, 7 a— UL
MACT RLADAA v FTMACT RLADX A LT 7 MWRFETHAREMERH Y F
T, XALT T RMEIZT B —SVMACT RVASND RNT 7 4 v I BAAL T T A
VITARNT I FARIRIIDIED T T T 4 7 N, ZHUSE D R T = R
SO X2 T4 FOMBERRET DL ENHY 5, £ A3 K EtherChannel ™~
=y FBLOYA FMACT RLAZLIZHA FIDEZRETDHE. GARPINT 7 4 /b
NCHEMZR 7,

BB/ S 7= : [Configuration] > [Device M anagement] > [High Availability and

Scalability] > [ASA Cluster] > [Cluster Configuration] > [Site Periodic GARP] 7 + —/V
.

IR B —T =
A A TN AW
X, F U REN LR
BRREICET 514
H—T7 A A E
NHEHITRDEL
77

9.10(1)

AVH =T 2 A ADAT —Z AWHBRET DL ASAIZA v ¥ —T = A A% fEEL
LC~v—2 L, Z77RAEZhba=y F&HIrT % % T health-check monitor-interface
debounce-time =~ > R'% 7213 ASDM [Configuration] > [Device M anagement] > [High
Availability and Scalability] > [ASA Cluster] i CHE S 7= I U B LE T, =
DOERIZ, XU U IRENOBEIREBICEE T 54 v 24— 7 oA XTHHEIND L9 I
D FE L, T2& X, XU REED GRBEENIREEIZEAT L TV % EtherChannel D354
(AL TRV r— RSz, £RITAA v T BEDIT/ - T3 EtherChannel 74
E) L TR AR ERLSTAHIET, MDDy TAZ 2=y FOFWR— D
RABENEWHSHBSZIT T, 79 RAF 2=y h ETA v E—T oA AN T —FKR
SNLOEHSZENTEET,

ARSI HEEIZH Y 5 A,

ERREE S I B )
Mz 7 A X IZHESN
95

9.92)

LIHTE, <07 —REBIZLV 7 T2 F 2=y M7 TAIDLHIRSHTVEL
7o ZORBEEMRR L2, FEITY 7 AZIZHSMT HLERHY £ L, BifE
i, 2=y MIT 74V TS50, 107, BELV20 5OMIETY 72X IZHBRIC
BEMERITLES, ThoDEEBETEEd, WHoMEIZE, 77 ) r—va
YRIDZ A LT N FELET TV r—a s AT =2 RARENRH Y FT,

BB E 7134 S 7=l - [Configuration] > [Device M anagement] > [High Availability
and Scalability] > [ASA Cluster] > [Auto Rejoin]

7T AL OIEHEMED R
WhI L AR— 71
ragrxtoe—r0
Z v AR— MR
LR ORI

9.92)

2=y NITEDT TAXDEFMEDEW N T VAR— Ny 7 7 EAREHEERE LT,
Ny Zy7inaryba—) FL—rTH2EWIRo7z it ry b Fa vy 7o/
BERBE T F L,

B E XA T &z~ 2 R @ show cluster info transport cp detail
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ASA 5000-X U —X |99(2) |ASANA v H—T = A AEEENRELTWNDE R L, ASA5500-X ¥V —X ED
WL TA v E—T7 = IG5 ANy FRBIBRENDIETOT AT L AR ARETIA LI F
A AEEEL L Tv— L7z ZORREBIZEY, A ¥ —T oA ADEL LRt Ed, 77
74512 IR TE TRE VAR A ELS AL EBEOREMNELS RD I LICEELTLLEE Y, [V
TNy L AR B—=T 2 ADAT—Z AFFNREAET DL, ASAIFA VA —T oA A%EEL LT
=27 L, JITAREMPLa=y NEHIBRT D ETHRESNZI VRDEMELET, T
T AV NOT N AL 500 ms T, HRhZeEOFIFHIL 300ms ~ 9 P TY, T
FEREIZLARTIE Firepower 4100/9300 Cff fl T& £ L 7=,
B E 7213 S -l : [Configuration] > [Device M anagement] > [High Availability
and Scalability] > [ASA Cluster]
I FARY L TDYA 990 | VA FEIOTEMICEY, VT T4 v T Ta—DRy I T v =LA —
INEIR=S 45 F—= LTV A MZENNET, ZOHEEEICEL > T, VA hOEENSRESNE
Er
B E 7213 S 7o i : [Configuration] > [Device M anagement] > [High Availability
and Scalability] > [ASA Cluster]
JTAL 2=y ko~ |98(1) |2=y b~V AF = v 7 ORBEFEZ XV IRDOEICRETE £ R/MEIX37)

VAT w7 REER
Dk E

VIRIOER/MEIZ 8T L, ZOMEEIX, 2=y h ~NAF 2T XAvt—I0 0
Ax¥—L%, AL b=V T —=rDX—T T ITATMNHT—X L —rD/—h
E—MIEELET, "~ M= 2HTHE, 2 br— L7 L —2CPUDK Y
XU TRV a— ) T OBRIEDKBELEZ TN, 7T A% v 7 OfFHEME &
JEENED I EUET, RERFMEZECRETHE, Z T AZHIEY DAy E—Y
YITTIT 4 ET AN 5 EICERE LTS, RERFM A E S ERET DR
WXy N =2 25+ 5 22880 LET, 282013, HAHRERRFREOMIC
3O0ODN—FhE—hF Ay B—UNEFEET DD, 7T7AXG) 72N L ThHD
=y " BRlO =y h~ODping NEREFFRIBLUNIZE S Z L 28 L9, REEE
%03 ~07 I CELZRICASA Y 7 vy =T X 77— RLESE, HFiln
RENYR—FENTVWARNDT, ZOREITT 74V FDIBICREY £3,

WO A2 F ¥ L7z, [Configuration] > [Device Management] > [High Availability
and Scalability] > [ASA Cluster]
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Favrxua—=n1 |990) |F—F B A —DNRT =~ AEl L, YA NI TAEZV L TDRNTT 4T

YP—var  F—4F% EHEFFT 72012, Ta LA un—h ) B—ra rEARCTEET, @E, Ly

VHE—DY A NEHT T PHRIIFFEDY A FND T T AKX A= |ZXoTr—R AT 231, BTSN

ALY T DikE TWET, LL, ASAIMEEDY A FDORALNR—=ITFT 4 L7 X o—)L&E ) YHT
9, T Fu—nIP—va ik, EELRILCYA o —0L T 4
LA, OV A MCOIFEARER 70— L T 4 LI X LW BINDOT 4 LT 4
0= LRNENCIRD T, FTEEET 4 LI AREY A MIFET D L T 3 —
< ANMEELET, £, TOFAENRKI LGS, v—h AT 0 L7 ZITIFE
CHA M THLWEROFTAEEZIBIRLET, Fue— T 4 LI XL, 7T AH
AUNR=DRIDOY A T ZNDERDO /T NeZET 555 A S ET,
WO &5 LE L7=, [Configuration] > [Device Management] > [High Availability
and Scalability] > [ASA Cluster] > [Cluster Configuration]

—F v RE LA ,%(9.6(1) | 2% K EtherChannel D/L—F v RE— RTOYA "NEZ F2Z Y L TOHEA. A

> K EtherChannel “&— MEBID MAC 7 R L AIZIMA T, A MEBDIP T FLAEZRETZ DL L9170

KoHA NEFH O IP FL=, YA FIPT RLAZBNMTHZEIZLED, 72—V MACT RLANDLD

T RLADR— | ARP JGA #HIET A 72012, —T 4 » ZRIBEORIFIZ 72 Y 7242720 Data Center
Interconnect (DCI) A DOBENI L 54— —L A KT AHR— M (OTV) T
NAAD ARP BB HERAT 22 ENTEET, MACT RLRAZ T 4 VXS 57
OIZ VACL i TE 720021 »FIZiE, ARP BENSME T,
WO &2 5% L E L7z, [Configuration] > [Device Setup] > [I nterface Settings] >
[Interfaces] > [Add/Edit Ether Channel Interface] > [Advanced]

ASA 5516-X TD 7 Z |9.5(2) |ASAS516-X N2 2=y b 7 T AX Y R—= T DHLHCR0E L, BATA B

AH ) T DY HR— - ATIE, 22=y b FZRAFZ VU ITRT 740 v TEIMESILTWET,
ZEW X7 ASDM HH X H D 1A,

P4 M7 r—=EtY |9.5(2) |Cisco Locator/ID Separation Protocol (LISP) D7 —F7 7 F ¥ (X, T34 ZAID %D

T 4 D LISP A > A~
7av

TN 2 ODRINDHF LN T AR—RTSEEL, = R—DOBITE T FA T
NI L TEBEMIC LET, ASAIX, BITEEDOLISP N7 7 4 v 7 &L, £D
WEHE L — LV AR I FRAZ) U PHEAICIEHTEE4, ASAY T AKX AL 3—(,
BAIDKR T =2 LA R R —F E7 I AT b FL b—F ORO LISP b
T4 I EREL, 7a— A —F—OFESFTEHIRY A MIETLET,
WOBEENBEANFEZITEFEINE LT,

[Configuration] > [Device M anagement] > [High Availability and Scalability] > [ASA
Cluster] > [Cluster Configuration]

[Configuration] > [Firewall] > [Objects] > [Inspect Maps] > [L1SP]
[Configuration] > [Firewall] > [Service Policy Rules] > [Protocol | nspection]
[Configuration] > [Firewall] > [Service Policy Rules] > [Cluster]
[Monitoring] > [Routing] > [L1SP-EID Table]
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XY U7 JL—F 9.52) |F+ V7T ZL— REFITREL PAT Tl, NAT 21 EIC 1 DDOR— FE#HLAZE Y Y
NAT O b2 7 = — )b TERHDOTIIFARL, HEARAMIA— DT oy 7 2E0 Y TEHZ N TEXET (RFC
F— =B L TUWASA 6888 LML TL7ZEY) , ZOMRBIL, 72— A —"—BLWNASA 7 T AXD
7T AL T TH BATHR—FENET,
Ak B S EE B 0 £ A,
IIGAZY T FL—1952) |[FT BT, TRTDOLLT FTRAZ Y T A X ME, %L DO FLL~ULDA X
Ay N Y OFRTE A HE Y RLAMZ, PL—ARy T riIZEGENET, LV EILLDA R baD b L —
RLyr A&HIRT D720, 7 TAXDE/NFL—A LUV ERETEET,
EESNBHEIESH Y EH A,
N—Fv R 7747 |951) | L—F v FE— T, &A% KEtherChannel V1 FH 2 S22V oV a{lifl4 5 2
7 g —)LF— KD AR CMTEEST, MACT RLADT7 T v 72T, A v Z—T A ADY
> K EtherChannel ® A RIOMACT RLARH A hD2=y h ETHETEDHLIC, KT TAE A
A~ TAEZY T N—DY A FID ZREL £,
Pk (?%4) bl WO 228 L% L7=, [Configuration] > [Device Management] > [High Availability
MAC T R and Scalability] > [ASA Cluster] > [Cluster Configuration]
AVH =T 2 A AFE|950) | A F =T oA ZAFNTT T AZEINY > 7 BRI LT=35E . auto-rejoin E{EE B A
X7 7 A& s H<wA XTEET,
3 - A
7 %E&.Lft%” » WOMH Z# A L% L7, [Configuration] > [Device Management] > [High Availability
auto-rejoin BIED ASA and Scalability] > [ASA Cluster] > [Auto Rejoin]
T ITAEDIAE <A
"
ASA 7 T A X3, 9.5(1) |ASA 7 7 A&, GTPvl BXOYGTPv2 A v A7 ¥ g &Y HR—FLET,
GTPvl & GTPv2 %= - i
= - X A,
e L ERINI-mmEiEH 0 £
ASAV FAEZ Y 7D |95(1) |75 REZ Y IR, ASAIZT 74 /L R T, HBESNTWAN—RY =27 E 2 —
N—=RT =T TV a— L (ASA FirePOWER £V 2 —)L72 &) O~ LA FT=X— Y U 75T 0VET, BED
LD~V AFT=R— N R 2T B 2a— LOBEECL > C T z— A —NR"—% N H—F 52 L n¥EF
> 7 O LLBRWERIE, Va0 =4—) T 5T 4 —T I TEET,
WOWmEZH LE L7z, [Configuration] > [Device Management] > [High Availability
and Scalability] > [ASA Cluster] > [Cluster Interface Health Monitoring]
TCPEEG D7 T A X4 |9.5(1) | ZDMEEET, T A L7 Z 1N I T v 7 70 —VEROBIEIZ L D IFEIR N E 7 17—

BLRIE

WZBET S TAREREE) 2P TE T,

WO ZEH A LE L7z, [Configuration] > [Device Management] > [High Availability
and Scalability] > [ASA Cluster Replication]
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D ASA 7 T AH D~ THZENTEET, 74T, A= FFr 31, TE, BIXUOHE -0
IWAFT=H—Y U TD OYEA L H—T 2 AT~NVAET=L =Y VT NA F—T W THET, ~Ib
HEIZT 42— AF=Z—U U T VLANY T A v —T = A A, £7213 VNI ° BVI 72 & OfABA
7 Ak VH—T oA ATRHITENE YA, ZTAZEY v DE=H =T U TIIFRET
XFEHA, TOY T ITREICE=FA—INTWET, =&z, BHA VX —T =4
Al MEUNDA B —T 2 AD~NVAEF=EZ— U T T 42— T 5
ZLENRTEET,
WOMH % & A LE L7, [Configuration] > [Device Management] > [High Availability and
Scalability] > [ASA Cluster] > [Cluster Interface Health Monitoring],
DHCP V L—® ASA |94(1) |ASA 7 JAHX CDHCP YV L —%2RECTEET, 7747 h®DHCPERX, 7T
ISR T DY ATV RFDOMACT RLADNy VaZfli LTI TALX AN |Za— RNNT R X
R—k NET, DHCP 7 A4 7 v b BIL OV —_R—HEEEIX AR — b SN TWEFA,
EESNEEEILH Y ER A,
ASAZ S AZ Y7 T|94(1) |ASA Y G AZTSIPA VAT Vg VEBRETCXET, filfllve—3, £E0a2=y
DSIP AV ART 5 FNCERTEETN (=R RT3 T D) | TDOFTFT—H ZJu—FFE L
DY R— h = MIEETAMERH Y £9, TLS X VB EITTR— SN TWER AL
ERINTEELIH 0 FHA,
Wi b U—27RBIC|93Q2) | KV A FORNERy hTI—7 2 F—F T2 L—FBIZ T AT L b B—F
ASA 7 G AKX 77 A DY TAZEBAL (AKAA—A R =X MEAN) | A FMEIZHE VLAN Z455E
T — B Z T b TEET, ==V A T AF— MR (OTV) OFERHEZHELEL 55, F—
SLUART L N E— N2 A N—FZDEETHMACT FLABIOIPT RLARH A METRAZ VLA
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[Home] > [Device Dashboard] [Home] > [Cluster Dashboard] [Home] > [Cluster Firewall
Dashboard] [Configuration] > [Device Management] > [Advanced] > [Address Pools] >
[MAC Address Pools] [Configuration] > [Device Management] > [High Availability and
Scalability] >[ASA Cluster] [Configuration] >[Device Management] > [L ogging] > [Syslog
Setup] > [Advanced] [Configuration] > [Device Setup] > [I nterface Settings] > [I nterfaces]
>[Add/Edit Interface] > [Advanced] [Configuration] > [Device Setup] >[I nter face Settings]
> [Interfaces] > [Add/Edit Interface] > [| Pv6] [Configuration] > [Device Setup] > [I nterface
Settings] >[I nterfaces] > [Add/Edit Ether Channel I nterface] > [Advanced] [Configuration]
> [Firewall] > [Advanced] > [Per-Session NAT Rules] [Monitoring] > [ASA Cluster]
[Monitoring] >[Properties] > [System Resources Graphs] >[Cluster Control Link] [Tools]
> [Preferences] > [General] [Tools] > [System Reload] [Tools] > [Upgrade Software from
L ocal Computer] [Wizards] > [High Availability and Scalability Wizard] [Wizards] >
[Packet Capture Wizard] [Wizards] > [Startup Wizard]
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